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CAPÍTULO 1: INTRODUCCIÓN 

 

1.1. Motivación 

En esta memoria se realiza un estudio de propagación de ondas electromagnéticas en una red 

de comunicaciones WiFi bajo el estándar IEEE 802.11. El trabajo viene motivado por la necesidad 

de formalizar conceptos y procedimientos de diseño de propagación de un sistema de 

comunicación vía radio y la necesidad de saber escoger de manera correcta entre los diferentes 

modelos y escenarios que se presentan en los diferentes software de análisis y simulación. 

Para la instalación de sistemas de radio móviles, los modelos de propagación de ondas son 

necesarios para determinar las características de propagación para cualquier configuración 

arbitraria. Las predicciones son necesarias para la planificación adecuada de la cobertura, la 

determinación de los efectos de trayectos múltiples, así como para la interferencia y los cálculos 

de células, que son la base del proceso de planificación de la red de alto nivel. Con la introducción 

de servicios inalámbricos de banda ancha en redes inalámbricas de área local (WLAN), las 

propiedades del ancho de banda y las restricciones en potencia estipuladas son importantes para 

el proceso de planificación. Es por ello por lo que cada vez es más complicado poder aplicar un 

modelo teórico en un entorno complejo y variante obteniendo una gran precisión y realizarlo con 

un coste temporal bajo. 

A principios de los años 80 aparecieron los primeros sistemas de comunicaciones móviles, 

la llamada primera generación de telefonía móvil (1G). Estos sistemas se basaban en la división 

del área de servicio en pequeñas celdas con el objetivo de poder usar las mismas frecuencias en 

diferentes celdas cuando éstas se encontrasen lo suficientemente lejos las unas de las otras para 

evitar interferencias. Actualmente, la asignación del espectro radioeléctrico está muy limitado y 

regulado, lo que implica que las nuevas tecnologías como las redes de telefonía 5G exijan una 

mayor planificación. Las herramientas de análisis de propagación ofrecen la capacidad de poder 

realizar dicha planificación previa, pudiendo obtener modelos que nos permitan anteponernos a 

situaciones que puedan provocar errores o problemas derivados de los efectos de reflexión, 

difracción o dispersión por los diferentes escenarios. También sería posible aplicar modelos 

teóricos, aunque su aplicación genera un coste temporal mayor a la que ofrecen los programas de 

análisis de propagación. 

Existe una gran variedad de escenarios y diferentes tipos de modelo para cada uno de ellos 

y es vital saber escoger el correcto para la aplicación que se desea utilizar. Entre los diferentes 

escenarios que podemos encontrar, tenemos: 

- Escenario interior (indoor): se centra en redes de propagación local como el WiFi. 

- El escenario urbano: suele ser utilizado para modelar la propagación de una torre de telefonía 

móvil vía 4G o 5G en un entorno más grande y con edificios de por medio. 

- Escenarios rurales o interurbanos: son entornos de propagación mayores como podría ser la 

señal de una estación base de televisión que se propaga por un gran territorio, con ciudades 

o zonas de baja densidad. 

- Escenarios complejos: como la propagación de señales en el interior de una estructura tipo 

túnel, dónde se produce una gran cantidad de reflexiones y refracciones.  

- Comunicaciones planetarias: como podría ser una aplicación vía satélite de radiotelevisión o 

para aplicaciones aeroespaciales en un aeropuerto, dónde se encuentran múltiples señales en 

un mismo entorno, etc. 
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1.2. Objetivos 

Uno de los objetivos de este proyecto es conocer el funcionamiento de las herramientas de 

análisis de propagación de redes de radiocomunicación y el correcto uso de éstas. Conocer cómo 

realizan el análisis de la propagación, que métodos utilizan y cuál de éstos se adhiere mejor a la 

realidad, comparar los métodos disponibles con medidas reales y poder concluir cuál de éstos es 

mejor para el caso que se pretende estudiar en este proyecto. 

El escenario en el que se centra este proyecto es la propagación de las ondas radioeléctricas 

de una red local WiFi en un entorno cerrado dentro de un edificio, concretamente el edificio de la 

Escola d’Enginyeria (EE) de la Universitat Autònoma de Barcelona. Se pretende focalizar el 

estudio en la propagación de la señal WiFi de la primera planta del ala de despachos del edificio. 

El objetivo principal es crear un modelo a través del software de simulación WinProp para 

analizar la cobertura WiFi en dicha planta. WinProp[1] es un software integral de análisis de 

propagación inalámbrica y planificación de redes de radio. Viene distribuido por la compañía 

Altair[2], una compañía global que ofrece soluciones software en informática de alto rendimiento 

y análisis de datos. 

Se utilizarán, dentro del escenario indoor, los diferentes modelos que WinProp nos ofrece 

para realizar la simulación y así poder compararlos entre ellos, todo esto junto con diferentes 

medidas que se realizarán con diversas herramientas para analizar el resultado proporcionado por 

el programa de simulación con los valores obtenidos mediante las medidas que se pretende 

realizar. 

 

1.3. Metodología del proyecto 

En este proyecto se creará un modelo de propagación de la primera planta del ala de 

despachos de la EE con la intención de estudiar el software de propagación WinProp y poder 

comparar los resultados con medidas experimentales. 

Las diferentes fases del proyecto son las siguientes, divididas en 5 capítulos principales: 

 

1.3.1. Estudio del programa de simulación de WinProp 

En primer lugar, en el Capítulo 2, realizaremos un análisis de todas las herramientas que hay 

integradas dentro del software WinProp. En particular, nos centraremos en WallMan y ProMan, 

que son los programas que utilizaremos en la simulación de la EE. 

A posteriori del estudio teórico, se pretende realizar un seguido de simulaciones a través de 

modelos DEMO que Altair nos ha proporcionado para poder complementar el estudio teórico 

realizado. 

 

1.3.2. Modelado de la planta primera del ala de despachos de la EE 

Una vez realizado el estudio preliminar de los programas a utilizar y sus modelos, en el 

Capítulo 3, comenzaremos con la construcción del plano de la planta de despachos de la EE, 

dónde se expondrán los pasos más significativos de la construcción de la base de datos y de la 

configuración de la simulación. Se realizarán simulaciones con los diferentes métodos que 

proporciona WinProp y se compararán entre ellos.  
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1.3.3. Campaña de medidas 

Tras los resultados de la simulación, en el Capítulo 4, se pretende realizar una campaña de 

medidas experimentales para obtener la potencia de la señal WiFi y compararlas con la simulación 

realizada. 

Primero se evaluará diferentes software disponibles de análisis de red. Se escogerá uno de 

ellos y se realizarán las medidas para contrastarlas con WinProp. 

 

1.3.4. Conclusiones 

Finalmente, en el Capítulo 5, una vez hayamos obtenido los diferentes resultados en cuánto 

a los diferentes modelos de simulación, que nos ofrece el software WinProp, los diferentes 

resultados obtenidos en la campaña de medidas, los costes computacionales de los diferentes 

modelos, su precisión respecto a la realidad y su correlación con las medidas experimentales, se 

redactará la conclusión del proyecto debatiendo sobre las ventajas e inconvenientes de cada uno 

de ellos y escogiendo el que a priori es mejor, para la simulación que se ha querido realizar. 
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CAPÍTULO 2: WINPROP 

2.1. Concepto 

WinProp es una herramienta de Altair utilizada para el modelado de señales 

electromagnéticas en diversos espacios y medios, tales como el interior (indoor), medios urbanos 

(urban) y suburbanos o rurales (rural-suburban), medios subterráneos (tunnel) o medios variantes 

con el tiempo (time-variant) cuyas aplicaciones podrían ser la automoción o la comunicación 

espacial, por ejemplo.  

Para la realización de este proyecto, se va a utilizar el software WinProp que no deja de ser 

un conjunto de programas que nos ofrece la posibilidad de generar un modelo de propagación 

dentro de un escenario, pero realmente ¿qué herramientas ofrece WinProp?, ¿para qué se utilizan? 

y, lo más importante, ¿qué herramientas de WinProp vamos a utilizar para este proyecto? 

Antes, vamos a responder a la pregunta de por qué utilizamos WinProp. Principalmente 

porque Altair nos ha permitido el uso de su software, pero ¿qué alternativas existen en el mercado? 

 

2.1.1. Alternativas a WinProp 

A diferencia de las herramientas de análisis y diseño de antenas, no existen demasiadas 

herramientas en el mercado que realicen este tipo de análisis de propagación, por lo que no es 

fácil encontrar un programa que cumpla con todas las exigencias y a la vez sea sencillo de utilizar. 

Una de las herramientas que pueden usarse como alternativa a WinProp es Wireless InSite 

software[3], una herramienta de la empresa Remcom[4], que igual que Altair ofrece soluciones 

software en informática de alto rendimiento. Wireless InSite es una herramienta parecida a 

WinProp que permite el análisis y la predicción de la propagación de las ondas radio en entornos 

urbanos, interiores, rurales y túneles. 

 

 
Figura 1: Resultado en WinProp de una combinación de escenarios interiores y urbano.[5] 
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Figura 2: Resultado de un escenario interior en Wireless InSite.[6] 

 
Figura 3: Resultado de un escenario urbano en Wireless InSite.[7] 

A diferencia de Winprop, que ofrece un resultado 2D (Figura 1), esta herramienta está más 

centrada en los resultados en 3D de los diferentes dispositivos y su diagrama de radiación (Figura 

2), aunque también ofrece resultados en 2D (Figura 3). 

A priori, ambos programas permiten realizar las mismas funciones. Habría que entrar en más 

detalle en la precisión de ambos programas y cuál de éstas se acerca más a la realidad, pero en 

este proyecto no nos vamos a centrar en ese tema. 

En cuanto a la interfaz del programa, en mi opinión, es más intuitiva la interfaz de WinProp 

a la interfaz de Wireless InSite, ya que WinProp tiene sus herramientas agrupadas en diferentes 

barras visibles mientras que Wireless InSite las tiene agrupadas en una única barra de 

herramientas. 

Otra alternativa a WinProp y al uso de programas de simulación es aplicar modelos de 

propagación empíricos para la aplicación concreta del escenario, como los modelos UIT[8] o 

IEEE[9]. Este último método sería el más costoso ya que se debería de realizar todo el cálculo de 

manera manual y es muy complicado tener en consideración todos los efectos de propagación en 

entornos complicados y grandes. El uso de las herramientas de propagación nos permite realizar 

esos cálculos con un menor coste temporal y con una mayor precisión. 
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2.1.2. ProMan (Propagation Manager) 

Es la herramienta central de WinProp. Se utiliza para simular y evaluar los modelos y 

escenarios que hayan sido creados. En este programa se encuentran las herramientas necesarias 

para analizar la propagación de las ondas electromagnéticas, a través de establecer en el plano o 

mapa creado anteriormente con WallMan, los diferentes puntos de emisión de radiación, como 

puede ser un router o una estación base. 

Con ProMan, además, puedes importar el modelo de comportamiento de la estación base o router 

a través de un archivo ffe que podemos exportar de FEKO[10], un software de simulación 

electromagnética de Altair que nos permite simular los efectos de radiación de dispositivos o la 

interacción con estos. Por ejemplo, una vez hayamos modelado el comportamiento de nuestro 

router o nuestra estación base lo incorporaremos a ProMan, de este modo podemos maximizar la 

precisión de nuestra simulación, empezando por simular la fuente de señal y después su modelado 

en una situación real. Durante el proyecto, veremos cómo importar un archivo ffe para modelar la 

estación base. 

2.1.3. WallMan (Wall Manager) 

Esta herramienta de WinProp nos permite diseñar y crear el escenario dónde se va a realizar 

nuestra simulación. Tiene varias opciones de diseño: escenarios urbanos, escenarios rurales o 

suburbanos y escenarios indoor. 

Con esta herramienta podemos crear con cierta exactitud los modelos de escenario, ya que 

cuenta con un catálogo con diferentes materiales para simular las diferencias de los materiales 

utilizados durante la construcción real del escenario. Además, WallMan te da la posibilidad de 

importar nuevos materiales e incluso crear materiales nuevos con propiedades personalizadas para 

precisar mejor la propagación que posteriormente ProMan realizará. Durante el proyecto, 

veremos cómo importar nuevos materiales de una base de datos. 

2.1.4. AMan (Antenna Manager) 

Esta herramienta de WinProp realiza un análisis de las diferentes componentes de nuestra 

antena importada de otro programa como podría ser FEKO. 

Esta herramienta también permite crear diagramas de radiación personalizados. 

2.1.5. Otras herramientas de WinProp 

Además de las herramientas descritas también se pueden encontrar las herramientas de 

CoMan (Connectivity Manager), CompoMan (Component Manager) para crear y añadir nuevos 

componentes, OptMan (Optimisation Engine) y TuMan (Tunnel Manager) una base de datos 

gráfica (CAD) especializada para modelar túneles y estadios. 

 

2.2. Métodos de resolución 

Dependiendo de los requisitos en cuánto a precisión y recursos que se dispongan, se pueden 

escoger diferentes modelos de propagación. 

Los entornos en los que un sistema de radio puede ser instalado van desde los interiores hasta 

grandes áreas rurales. Por lo tanto, se requieren métodos de predicción de propagación de ondas 

que cubran todo el rango de macro, micro y pico-células, incluidos escenarios y situaciones en 

interiores o en entornos especiales como túneles o carreteras que necesiten de atención superior. 
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El uso práctico de modelos en escenarios reales precisa de aproximaciones, lo que requiere 

un proceso de modelado en diferentes etapas. 

Primero de todo deberemos digitalizar el entorno a modelar. Para ello se creará una base de 

datos en la que introduciremos todos lo necesario para modelar el entorno. Para medios rurales, 

la base de datos incluye información de la altura del terreno y el uso de éste. Para entornos urbanos, 

se tiene en cuenta la altura del edificio, la forma y la superficie de éste. 

El segundo paso es la definición de aproximaciones matemáticas para los mecanismos de 

propagación física. 

El tercer paso es desarrollar e implementar los enfoques deterministas y empíricos para los 

diversos entornos sobre la base de datos. 

Centrándonos en el escenario indoor, tenemos un canal que difiere considerablemente con el 

exterior. La distancia transmisor-receptor es más corta, por lo que se reduce el tiempo de 

transmisión y los ecos, aunque su atenuación es mayor debido a las paredes y demás objetos. Los 

modelos de propagación indoor se pueden clasificar en tres grupos[11]: 

1. Modelos empíricos de banda estrecha. Se expresan en forma de ecuaciones que se 

obtienen ajustando el modelo a los resultados de medición, dándonos como resultado la 

atenuación de la densidad de potencia de la onda propagada (path loss). 

2. Modelos empíricos de banda ancha. Nos permiten añadir características de banda ancha 

como la propagación del retardo (delay spread). 

3. Modelos deterministas. Son modelos de cálculo que simulan físicamente la propagación 

de las ondas electromagnéticas, proporcionando información de banda estrecha y banda ancha del 

canal dentro de los edificios. 

 

2.2.1. Requisitos de la base de datos 

Lo esencial para cualquier modelo de propagación es una base de datos que describa el 

entorno. Para el modelado indoor, los elementos del edificio se clasifican en clases (muros, suelo, 

puerta, etc), se especifican con coordenadas según su ubicación y las propiedades del material, 

como son el grosor, la permitividad y la conductividad. 

2.2.2. Modelos indoor 

Si acudimos a Proman y nos dirigimos a los parámetros de configuración de la simulación 

(Project > Edit Project Parameters…), en la pestaña Computation, se permite escoger 

entre los diferentes modelos de propagación que WinProp dispone, los cuales se detallan a 

continuación. 

2.2.2.1. Modified free space model (Modelo de espacio libre modificado) 

Este modelo calcula la pérdida de ruta de manera similar a la pérdida en espacio libre con un 

exponente y compensación ajustable. Con esto se supone que la pérdida de trayectoria en exceso 

(en dB) depende linealmente de la distancia con un coeficiente de atenuación n según: 

𝑙𝑀𝐹 = 𝑛 (20 log
4𝜋𝑑

𝜆
) + 𝑙𝑐                                                               (1) 

Este modelo no considera las paredes del edificio (Figura 4). Con valores para n y lc la 

predicción realiza círculos alrededor del transmisor con valores que van disminuyendo su 

intensidad. Los resultados de este método son bastante inexactos y únicamente sirven para realizar 

una aproximación. 
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Figura 4: Principio del modelo de espacio libre modificado.[13] 

 

2.2.2.2. Modelo de Motley-Keenan (MKM) 

Este modelo calcula la pérdida del rayo directo entre el transmisor y el receptor. A diferencia 

del modelo de espacio libre modificado, éste utiliza las ubicaciones exactas de paredes, suelos y 

techos. Considera los factores de absorción en las paredes. 

 
Figura 5: Principio del modelo de Motley-Keenan.[14] 

 

𝑙𝑀𝐾 = 𝑙𝐹𝑆 + 𝑙𝑐 + 𝑘𝑤𝑙𝑤                                                              (2) 

Siguiendo la ecuación 2 y como se puede ver en la Figura 5, kw equivale a la cantidad de 

paredes que atraviesa el rayo directo y lw la atenuación que hay en cada una de ellas. En este 

modelo considera que el material de los muros es el mismo para todos. 

 

2.2.2.3. Modelo COST-Multi-Wall (MWM) 

Este modelo proporciona tanto la pérdida del rayo como la pérdida en espacio libre 

incluyendo las pérdidas introducidas por las paredes y suelo o techo que traviesa el rayo directo 

entre el transmisor y el receptor. Este modelo considera las propiedades individuales de los 

materiales de las paredes y techos, pudiendo ser éstas distintas, siguiendo la siguiente expresión: 
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𝑙𝑀𝑊 = 𝑙𝐹𝑆 + 𝑙𝑐 + ∑ 𝑘𝑤𝑖𝑙𝑤𝑖

𝑁

𝑖=1

+ 𝑘𝑓𝑙𝑓                                                 (3) 

Dónde: 

lFS = pérdidas de espacio libre entre Tx y Rx. lwi = pérdidas de muros de material i 

lc = pérdidas constantes    lf = pérdidas entre los pisos 

kwi = muros penetrados de material i.  N = cantidad de materiales 

kf = pisos penetrados 

El principio de este modelo es idéntico al modelo anterior, pero considerando los materiales 

de la construcción. Tiene una baja dependencia de la base de datos de WallMan, lo que significa 

que el coste computacional no dependerá más de la cantidad de paredes que se le coloquen, sino 

del tamaño total del plano. Además, no tiene en consideración los efectos de guía de ondas que 

se pueden producir por la configuración de pasillos.  

 

2.2.2.4. Standard Ray Tracing (SRT) 

El modelo SRT realiza una predicción rigurosa del trazado de rayos en 3D con una precisión 

muy alta, pero con un elevado coste computacional. 

Los modelos deterministas se utilizan para modelar la propagación de ondas de radio 

físicamente, lo que permite tener mayor precisión en los efectos del medio ambiente. Otra ventaja 

es que permiten predecir varios parámetros de propagación a la vez, cómo la atenuación de la 

densidad de potencia de la onda propagada (path loss), la respuesta impulsional y el ángulo de 

llegada. 

Cuando se consideran longitudes de onda pequeñas respecto al plano analizado y al tamaño 

de los obstáculos en éste, se introduce el concepto de óptica geométrica, dónde se supone que la 

onda electromagnética se propaga a través de una línea recta influenciada únicamente por la 

refracción, la reflexión, la difracción o la dispersión (Figura 6) Para frecuencias Wi-Fi, este 

criterio se cumple suficientemente dentro de un edificio. 

 
Figura 6: Principio del modelo de rayos ópticos.[17] 

 

2.2.2.4.1. Propagation paths (caminos de propagación) 

Cada transmisión a través de una pared, cada reflexión y difracción cuenta como una 

interacción. Mediante la configuración de SRT se puede definir el número de interacciones que 

deseamos calcular (Figura 7). 
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Figura 7: Configuración específica de los parámetros de SRT (válido también para IRT) 

 

Mediante el valor Max. podemos definir la cantidad máxima de interacciones permitidas. 

También se puede determinar la pérdida máxima de los rayos. Dependiendo de la estructura del 

edificio se escogerá un valor superior o inferior. Por ejemplo, para una estructura con un largo 

pasillo o varios muros a los que debe traspasar, se deberá introducir un valor mayor a una 

construcción más simple. 

Hay que tener en cuenta que, al aumentar el número de interacciones aumenta el tiempo de 

computación, por el contrario, si reducimos el número de interacciones se reduce la precisión de 

la simulación. 

2.2.2.5. Intelligent Ray Tracing (IRT) 

Este método acelera la obtención de los modelos ópticos de rayos combinando las ventajas 

de los modelos ópticos y empíricos[18]. Todas las partes del edificio se subdividen en mosaicos 

y las cuñas en segmentos. Todas esas relaciones se realizan en la etapa de preprocesamiento 

(mediante WallMan) ya que son independientes a la ubicación del transmisor. La configuración 

es la misma que en el modelo SRT. 

Los resultados de la predicción 3D son más rigurosos y precisos ya que se pueden tener en 

cuenta muchas interacciones. La gran ventaja que ofrece es su menor tiempo de cálculo gracias 

al preprocesado anterior realizado con WallMan. 

 

2.2.2.6. Computation of signal level along propagation path 

Uno de los parámetros de configuración en ProMan es Computation of signal level along 

propagation path, en el que se permite escoger entre el modelo determinista y el modelo empírico 

para cualquiera de los modelos escogidos entre los anteriores. 
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El método determinista utiliza las ecuaciones de Fresnel para determinar las pérdidas por 

transmisión y reflexión y el GTD/UTD[19] para las pérdidas por difracción. Este modelo tiene un 

tiempo de cálculo mayor y utiliza los parámetros de permitividad, permeabilidad y conductividad 

de los materiales. 

El método empírico utiliza cinco parámetros: pérdida mínima de rayo incidente, pérdida 

máxima de rayo incidente, pérdida de rayo difractado, pérdida de reflexión y pérdida de 

transmisión. Se puede especificar un offset en la configuración para adaptar la medición. 

2.2.2.7. Preprocesado 

El preprocesado se realiza en WallMan y divide cada pared en mosaicos y cada borde en 

segmentos. Estos mosaicos y segmentos los utiliza para determinar las relaciones de visibilidad 

entre los elementos para la predicción de las rutas de propagación. 

El tamaño de los mosaicos tiene un impacto importante en la predicción. Si se disminuye su 

tamaño, aumenta su precisión en la predicción, pero, además, aumentará también su tiempo de 

computación. 

El tamaño máximo de mosaicos y segmentos se puede especificar, siendo recomendado 

valores en mosaicos de 1 a 3 metros y en segmentos de 2.5 a 3.5 metros, dependiendo de la 

estructura a analizar y la precisión que se desee obtener. Cuanto mayor sea la frecuencia de 

análisis, se deberá tener en consideración que, usando valores mayores en los segmentos, la 

resolución final del análisis se verá afectada negativamente. 

 

2.3. Workflow general 

Como hemos visto anteriormente, WinProp se divide en diferentes programas cuyo 

funcionamiento es complementario uno con otro. Para la realización de este proyecto, 

utilizaremos principalmente los programas WallMan y ProMan. WallMan se utilizará para 

generar el database que posteriormente analizaremos en ProMan. 

WinProp tiene el flujo de trabajo de la Figura 8. 

 
Figura 8: Workflow de WinProp 
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WinProp propone empezar por el análisis de la antena que se va a utilizar como estación base. 

Para ello se utiliza el programa AMan. AMan como hemos comentado anteriormente nos permite 

crear diagramas de radiación personalizados o construir un modelo 3D a partir de los planos E y 

H de los diagramas de radiación de las antenas. 

Mediante WallMan se creará la base de datos que deberemos analizar a posteriori con 

ProMan. El modelado de la antena y la creación de la base de datos son independientes y pueden 

realizarse en paralelo. 

ProMan, nos permite importar un modelo de antena, por lo que el paso de AMan no es 

imprescindible y, en el caso de este proyecto, es una herramienta en la que no se va a entrar en 

detalle. 

2.3.1. WallMan. Construcción del escenario a analizar. 

Gran parte de este proyecto se basa en la construcción del escenario a analizar, en este 

apartado se va a realizar una construcción genérica de un escenario indoor para analizar el 

funcionamiento del programa. WallMan nos permite crear paredes y muros, abrir aperturas en 

ellos como ventanas y puertas, crear posteriormente el suelo y el techo de la construcción. 

2.3.1.1. Creación y configuración de la base de datos. 

Lo primero que tenemos cuando abrimos el WallMan a través del launcher, es una ventana 

en blanco. Para iniciar nuestro proyecto lo que debemos hacer es crear una nueva base de datos 

para posteriormente simular a través de ProMan. Iremos a File > New Database. Se nos 

abrirá una ventana como la de la Figura 9 para seleccionar el tipo de database que queremos crear. 

Seleccionaremos Indoor database y Draw manually. Además de las opciones que hemos 

escogido, en la ventana de la Figura 9, podemos escoger las opciones Draw with bitmap in 

background, que nos coloca una imagen de fondo para poder tener una guía, y Convert File 

que nos permite importar un archivo GIS o CAD, archivos de codificación de información 

geográfica que nos permitirán tener una base en el momento de construir nuestro modelo. Para 

más información ver Anexo II. 

A continuación, importaremos un catálogo de materiales para poder construir el edificio con 

materiales con propiedades reales, para ello, en el apartado de Material catalogue haremos clic en 

el botón Browse e iremos a la ubicación dónde tengamos el archivo 

“GlobalMaterialCatalogue.mcb” que viene incorporado en la carpeta DEMO que Altair nos ha 

proporcionado para la realización del proyecto. Seleccionamos Abrir y luego damos en OK. 

WallMan nos permite importar diferentes catálogos de materiales e incluso crear nuestro propio 

catálogo, aunque en este proyecto no entraremos en detalle. 

 
Figura 9: Selección del modelo de base de datos a utilizar en WallMan. 
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Figura 10: Ventana para los valores por defecto creados a través de WallMan 

 

 
Figura 11: Ventana en blanco de la Database de WallMan. Más detalles en el Anexo II. 



23 
   

En la siguiente ventana que se nos abre (Figura 10), nos permite configurar los valores por 

defecto de las construcciones que vayamos a realizar. En el apartado Geometrical 

Parameters for Orthogonal Drawing Mode seleccionaremos la opción Object 

relative to current plane y le diremos, en nuestro caso, 4m, altura aproximada de las 

salas del edificio de Ingeniería. La opción Upper and lower coordinate defined 

individually (and absolute) lo utilizaremos más adelante para la colocación de las 

puertas y las ventanas. 

Una vez establecidos los valores por defecto de los materiales, pulsaremos en OK. Nos deberá 

aparecer la ventana de la Figura 11. En esta ventana tenemos las 3 vistas de los planos y una 

cuarta en 3D. 

2.3.1.2. Parámetros básicos de la configuración. 

A continuación, realizaremos la configuración de los parámetros locales que nos permitirán 

crear con mayor precisión el plano de nuestra construcción. Para ello iremos a la pestaña 

Settings > Local Settings. 

 

 
Figura 12: Local Settings de WinProp. 
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En la ventana que se nos abrirá (Figura 12) podremos configurar los diferentes parámetros 

locales del programa. Entre ellos tenemos la habilitación del Grid, el número de veces que 

podemos retroceder en caso de error (guardado en un buffer), opciones de acelerado de la 

visualización y las diferentes opciones de visualizado disponibles: Vista en 3D, rellenado de 

objetos (Fill Objects), visualización de los planos XZ e YZ, mostrar en la visualización el grosor 

de los muros, etc… Una vez configurado a nuestro gusto, proseguiremos con el dibujado del plano. 

En el anexo II se encuentra explicada la interfaz de WallMan. Se recomienda echarle un 

vistazo antes de continuar en caso de no estar familiarizado con el programa. 

 Anotación sobre la vista 3D: Dependiendo del tamaño de la ventana de la vista 3D, el 

programa WallMan automáticamente deshabilita la vista en 3D. Para volver a habilitarla es 

necesario acudir de nuevo a la configuración local y habilitar la opción Show 3D view de la 

Figura 12. 

 

2.3.1.3. Muros 

A continuación, vamos a crear los muros exteriores de nuestra construcción y posteriormente 

los interiores. Para añadir dichos muros, utilizaremos la herramienta de construcción Add 

polygonal objects with ortogonal walls and a ceiling. Esto nos creará la 

estructura externa con el suelo y el techo. Para finalizar la construcción deberemos hacer clic 

derecho del ratón. 

Una vez realizados los muros exteriores, dibujaremos las paredes internas de nuestra 

construcción. Para ello seleccionaremos la herramienta de construcción Add Objects 

Orthogonal y construiremos las paredes interiores haciendo clic en el plano y volviendo a hacer 

clic con el botón izquierdo para construir la pared. En caso de querer modificar o eliminar una 

pared, podemos utilizar la herramienta de selección Select Object para seleccionar la pared 

errónea y eliminarla si fuere necesario. 

 

2.3.1.4. Puertas y ventanas 

Una vez tengamos los muros externos y las paredes interiores, nos dedicaremos a dibujar las 

puertas y las ventanas. Primero empezaremos con las puertas. Para ello deberemos ir a Edit > 

Default Values y seleccionar en la ventana la opción Upper and lower coordinate, las 

definiremos con los parámetros de la Figura 13, teniendo en cuenta la altura real de nuestras 

puertas. En Material Properties of new Subdivisions deberemos introducir el tipo de 

material de las puertas que se vayan a utilizar. En este caso, madera de 5 cm. 

Una vez tengamos configurado de nuevo los valores por defecto construiremos las puertas 

usando la misma herramienta Add Objects Orthogonal de nuevo y colocando las puertas 

encima del muro. Nos aparecerá un cuadro como el de la Figura 14 en el que deberemos 

seleccionar la opción de Create subdivisión > Subdivision with individual 

material properties y pulsar OK a continuación. Podremos observar cómo se crea una 

división de color morado en el mapa en el lugar dónde hayamos indicado la puerta. 

La opción Hole in Surrounding wall de la Figura 14 se utiliza para abrir una apertura 

con los valores de altura definidos en la Figura 13 en el muro seleccionado. 
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Figura 13: Valores por defecto para crear una puerta de madera de unos 5 cm de grosor. 

 

 
Figura 14: Cuadro de subdivisiones. 
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Una vez construidas las puertas, se realizarán las aperturas para las ventanas. Para ello 

volveremos a ir a Edit > Default values y esta vez vamos a configurar el apartado de 

Upper and lower coordinate según la altura en la que se encuentren las ventanas. En el 

apartado de materiales, esta vez seleccionaremos Glass (vidrio) con el grosor que más se aproxime 

al real que queramos simular. Pulsamos en OK y volvemos a realizar las subdivisiones como 

anteriormente se ha hecho con las puertas. 

 

2.3.2. ProMan. Análisis del escenario creado. 

Una vez visto como crear un escenario en WallMan, vamos a ver como simular un escenario 

en ProMan con la configuración básica del programa. Utilizaremos el modelo construido 

anteriormente. También puede ser usado cualquiera de los modelos indoor DEMO 

proporcionados por Altair. 

La primera vez que se utiliza ProMan, se abre una ventana de parámetros globales. Dichos 

parámetros no son relevantes para un proyecto o database específico, por lo que saltaremos dicha 

ventana y nos centraremos en configurar los parámetros locales. 

Lo primero a realizar será la creación de un nuevo proyecto en el que importar nuestra base 

de datos creada en WallMan. Para ello nos dirigiremos a la pestaña File > New Project. En 

la ventana que se nos abrirá (Figura 15) seleccionaremos Propagation Analysis en el 

apartado Wireless Technology, debido a que en este caso nos vamos a centrar en simular una 

propagación local dentro de un edificio. En el apartado Scenario seleccionaremos Indoor 

Scenarios. En el apartado Databases introduciremos la ubicación de nuestro archivo idb que 

WallMan ha creado anteriormente o que importemos de otros programas. En el apartado de 

Polarimetric Analysis, la opción Full nos permite realizar el análisis considerando todas las 

rotaciones angulares ópticas, mientras que la opción Standard no es tan precisa en ese ámbito[20]. 

Si se selecciona la opción Full, algunos de los métodos no estarán disponibles para simular. Para 

esta simulación indoor es indiferente una opción u otra. Una vez rellenados los datos necesarios 

pulsamos OK y en la ventana que nos aparece introducimos una Height de 1.2 m, altura donde 

suelen estar los receptores de ondas WiFi (portátiles en mesas, móviles, etc…). 

 
Figura 15: Ventana New Project con las especificaciones para iniciar un nuevo proyecto en ProMan 
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2.3.2.1. Puntos de acceso y antenas 

Una vez configurados los parámetros iniciales, para poder modelar la propagación, 

deberemos colocar en el plano nuestra antena, en este caso WiFi, que nos permita generar la señal 

para posteriormente modelarla. 

Para colocar nuestra antena en el plano seleccionaremos el botón Set Site. Se nos abrirá 

una nueva ventana para configurar el tipo de transmisor (Figura 16), seleccionaremos Site with 

sectors, debido a que las demás opciones no nos corresponden para esta simulación. Y en el 

apartado Settings seleccionaremos Omni Site ya que en nuestro caso tendremos un transmisor 

omnidireccional (Router WiFi), en caso de querer simular la propagación de antenas sectoriales 

de telefonía móvil, configuraríamos dicha ventana de acuerdo con los diferentes sectores que 

tendría la antena. Pulsamos OK una vez configurado. 

 
Figura 16: Ventana de configuración del transmisor. 

Se nos abrirá una nueva ventana (Figura 17) para configurar la celda de la antena. En ella 

tenemos varios parámetros de configuración como el estado y la ubicación de la antena (el 

parámetro Z nos indica la altura respecto el suelo o el nivel del mar de la antena). Nos centraremos 

en Transmitter Settings, en esta pestaña debemos configurar los valores de potencia y frecuencia 

de nuestro dispositivo transmisor. Para el ejemplo de este router estipularemos una potencia de 

transmisión de 20 dBm a frecuencia 2.4 GHz, escogiendo la opción EIRP (PIRE), teniendo en 

cuenta que en España la PIRE del WiFi está limitada a 100 mW[21]. En los parámetros de antena 

(Antenna Pattern) seleccionaremos Direccional/Sector antenna si lo que queremos, como 

en este caso, es importar un modelo de antena de otro programa como podría ser FEKO. Se nos 

abrirá el buscador de archivos para poder introducir el fichero ffe de nuestro router, una vez 

importados automáticamente se nos configura la ganancia de nuestra antena respecto a los valores 

dados en la simulación de FEKO. 

Deberemos repetir este proceso para tantos puntos de acceso como queramos introducir en 

nuestra simulación. 
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Figura 17: Parámetros de configuración de la Antena. 

 

2.3.2.2. Configuración y ejecución de la simulación 

A continuación, vamos a realizar la configuración de los parámetros del proyecto. Para ello 

iremos a Project > Edit Project Parameter. Se nos abrirá la ventana de la Figura 18 en 

la pestaña de simulación. En esta pestaña se nos permite configurar el área a simular, definida por 

la posición de los córneres, la resolución de los resultados y la altura de la simulación determinada 

anteriormente y que puede ser cambiada. 

 
Figura 18: Parámetros del proyecto. Pestaña de simulación. 
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Figura 19: Parámetros del proyecto. Pestaña propagation. 

 

En la pestaña Propagation podemos solicitar al programa los resultados que queremos 

obtener de los visibles en la Figura 19 y modificar el nombre del archivo de simulación. 

La pestaña Sites es la misma que utilizamos anteriormente para configurar la posición del 

transmisor y el apartado Components no lo utilizaremos para la simulación indoor que hemos 

realizado. 

En la pestaña Database (Figura 20) encontramos los parámetros de la base de datos 

utilizada. Object database hace referencia al catálogo de materiales importado al principio de 

la simulación junto a la base de datos WallMan. En Topography database no consideraremos 

nada al estar realizando un proyecto indoor. En Material Properties, consideraremos los 

valores importados de la database, como se muestra en la Figura 20. Los parámetros de RCS no 

se consideran para este tipo de simulación. 

En la pestaña Computation (Figura 21) podremos escoger entre los diferentes modelos que 

WinProp nos ofrece. Realizaremos una simulación con los modelos Modified Free Space y Multi-

Wall, modelo empírico y una tercera con el modelo 3D Standard Ray Tracing, modelo óptico, y 

compararemos los resultados obtenidos. 
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Figura 20: Parámetros del proyecto. Pestaña database. 

 
Figura 21: Parámetros del proyecto. Pestaña computation. 
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2.3.2.3. Visualización y comparación de los resultados 

Una vez simulado, nos aparecerá un cuadro a la izquierda con un esquema de resultados 

Results: Propagation como se puede ver en la figura 19. Allí tendremos diferentes opciones 

a escoger dependiendo de lo configurado para simular. Si seleccionamos cada una de ellas nos 

aparecerá sobre el plano la simulación de la propagación. En la barra de la derecha tenemos 

diferentes herramientas de utilidad que nos permiten obtener diferente información sobre lo 

simulado por el programa como puede ser la ruta de la señal directa, un gráfico con la respuesta 

impulsional dependiendo del lugar en el que se coloque el cursor, etcétera. Dichas herramientas 

se encuentran detalladas en el anexo III del proyecto. 

 

En la propia barra de herramientas de utilidad encontramos la herramienta Line PLot 

(octavo botón de la Figura 22). A través de la herramienta Line Plot, podemos obtener una 

gráfica con la variación que hay en la potencia respecto a la distancia seleccionada en el mapa. 

En la Figura 23 podemos ver dicha gráfica en la cual hay presente la potencia marcada en la línea 

azul de la Figura 22. 

 

 

 
Figura 22: Visualización de los resultados simulados en ProMan. La línea azul indica el análisis realizado por el 

gráfico de la Figura 23. A la derecha, la barra de herramientas de utilidad. 
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Figura 23: Gráfico de potencia respecto a la línea marcada en la Figura 22 mediante la herramienta LinePlot. 

 

2.3.2.4. Comparación de modelos. 

Ahora que ya sabemos cómo construir una base de datos utilizando WallMan y cómo 

analizarla con ProMan, vamos a realizar una comparación de los métodos vistos anteriormente en 

este mismo capítulo. 

En este apartado realizaremos la comparación de los modelos MFSM (Modelo de Espacio 

Libre Modificado), MKM (Modelo de Motley-Keenan) y SRT (Standard Ray Tracing) utilizando 

en los tres casos el método empírico. 

 

 
Figura 24: Modified Free Space Model con el método empírico de la construcción del Capítulo 2. 
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Figura 25: Motley-Keenan Model con el método empírico. 

 

Si analizamos a simple vista los resultados de la Figura 24, podemos ver como el modelo de 

espacio libre modificado realiza la aproximación sin tener en cuenta las paredes de la construcción, 

ya que la señal pasa completamente a través de la pared del edificio sin sufrir ningún tipo de 

alteración. 

En la Figura 25, dónde tenemos el modelo de Motley-Keenan, podemos ver, en comparación 

con el anterior modelo, como sí se tienen en cuenta las paredes, ya que se puede observar 

perfectamente como añade esa pérdida provocada por ellas. Sin embargo, en este modelo no se 

tienen en cuenta las puertas y las ventanas que atraviesa la señal. Si la comparamos con la Figura 

26, a simple vista se puede observar la interacción de la señal con las puertas y ventanas de la 

construcción. 

 

 
Figura 26: Standard Ray Tracing con el método empírico. 
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Figura 27: Substract de la Figura 26 con la Figura 25. 

A continuación, hemos realizado una comparación más exhaustiva del modelo de Motley-

Keenan con el Standard Ray Tracing. Como hemos visto anteriormente, el modelo SRT realiza 

un trazado de los rayos 3D teniendo en cuenta las interacciones de éstos con el medio, como es la 

difracción, la reflexión, la dispersión y la refracción. En la Figura 27 se puede observar una zona 

naranja detrás de la habitación en la que se encuentra el router, eso es debido a la consideración 

que realiza SRT de las interacciones de la señal, por lo que nos devuelve un nivel de señal superior 

al método MKM que solamente tiene en consideración el hecho de que haya paredes. 

Si vemos el coste computacional que han tenido cada uno de los métodos, podemos ver como 

el método MFSM y MKM han tenido un tiempo de ejecución de menos de 1 minuto, mientras 

que el modelo SRT ha tardado en ejecutarse unos tres minutos. Por tanto, podemos decir que los 

métodos MFSM y MKM tienen un coste computacional prácticamente nulo comparado con el 

método SRT. Como hemos visto anteriormente, SRT analiza las interacciones de los rayos con 

todos los obstáculos que se encuentre, mientras que MFSM y MKM realizan cálculos 

matemáticos sin tener en cuenta si la señal sufre de difracción, reflexión, dispersión o refracción. 

Por lo que realizar la simulación en SRT ha supuesto un mayor tiempo computacional a cambio 

de obtener unos resultados más precisos. 
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CAPÍTULO 3: MODELADO DE LA PRIMERA PLANTA 

En este capítulo se exponen los pasos realizados con las diferentes herramientas de WinProp 

para el modelado y posterior análisis de la primera planta del ala de despachos de la escuela de 

Ingeniería. Se inicia creando la base de datos en WallMan para posteriormente analizarla en 

ProMan y comparar los resultados de los diferentes modelos utilizados. 

3.1. WallMan 

A continuación, se exponen los pasos clave utilizados para la construcción del modelo de la 

Escuela de Ingeniería en WinProp. 

Lo primero de todo, abriremos WallMan a través del lanzador Altair FEKO + WinProp e 

iremos a File > New Database. En la ventana que se nos abrirá (Figura 28) seleccionaremos 

Indoor database y Draw with bitmap in background. En el apartado de Material catalogue 

seleccionaremos “Browse” y cogeremos el catálogo de materiales proporcionado por Altair. A 

continuación, pulsamos OK. 

 
Figura 28: Selección del modelo de base de datos a utilizar en WallMan 

Se nos abrirá a continuación una nueva ventana para configurar los valores para los nuevos 

objetos de WallMan. Seleccionaremos los datos tal y como se muestra en la Figura 29. Con unos 

valores para los muros exteriores de 30 cm en ladrillo y una altura de las paredes de 4 metros. 

Dichos valores se han escogido después de realizar una medición de los parámetros [Anexo IV]. 

Los valores de propiedades para las nuevas subdivisiones no las tendremos en cuenta todavía, 

ya que primero realizaremos la construcción de las paredes exteriores e interiores y, después, 

colocaremos puertas y ventanas. Pulsaremos OK una vez configurado. 

En la siguiente ventana que se nos abrirá (Figura 30) deberemos introducir la imagen de 

fondo que utilizaremos como guía para la realización del plano de construcción de la Escuela de 

Ingeniería[22]. Haremos clic en el botón Add y seleccionaremos la ubicación de nuestra imagen 

a colocar de fondo. 
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Figura 29: Ventana para los valores por defecto creados a través de WallMan 

 
Figura 30: Configuración de la imagen de fondo para el plano en WallMan 
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De manera automática podremos ver como el programa rellena los valores Width y Height. 

En caso de conocer el tamaño real al que hace referencia nuestro plano podremos configurar 

dichos valores para que se ajusten a la realidad del plano. Nosotros a priori no conocemos la 

escala real a la que hace referencia el plano, debido a que se trata de una imagen extraída de un 

PDF y obviamente, como se puede observar en la Figura 30, el valor de Height y Width no se 

corresponde a la realidad, ya que la escuela no mide 7 km por 4 km, por lo tanto, realizaremos el 

reajuste de escala más adelante. Pulsaremos en Apply una vez configurado el plano de fondo y 

posteriormente Close. 

Ahora podremos ver como en nuestra ventana en WallMan se nos aparece el plano 

introducido tanto en la vista en 2D para el plano XY como en la vista en 3D (Figura 31). 

 
Figura 31: Vista principal de WallMan con el plano configurado de fondo 

 

 
Figura 32: Configuración del escalado en WallMan para el plano y demás objetos. 
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3.1.1. Reescalado del plano 

Tal y como hemos visto antes en la Figura 30, nuestro plano no está en la escala correcta, 

por lo que primero de todo debemos configurar dicha escala de manera correcta antes de realizar 

el resto del procedimiento. Para ello seguiremos los siguientes pasos: Iremos a Edit > Scale 

All Objects… y seleccionaremos By drawing a line fijado en Database origin, tal y 

como se muestra en la Figura 32. Pulsaremos OK una vez configurado de dicha manera. 

WallMan nos informará de que debemos de dibujar una línea y después nos pedirá el tamaño 

real de la línea dibujada. Le damos en Aceptar y dibujamos dicha línea. Nosotros lo que 

conocemos es el ancho del pasillo, 2.10 metros. Por lo tanto, debemos seleccionar el pasillo y 

después colocar la longitud de dicha línea en la ventana (Figura 33). Pulsamos OK y SÍ en la 

segunda ventana. Podremos ver como el plano se ha hecho pequeño. Para centrar la vista de nuevo 

en el plano, seleccionaremos el botón Fit to screen de la barra de visualización. 

 
Figura 33: Reescalado del plano. 

Una vez reescalado el plano, a continuación, realizaremos la construcción de las paredes 

exteriores de nuestro edificio. Empezaremos por construir la primera planta del edificio de 

despachos de la Escuela de Ingeniería. 

 

3.1.2. Construcción de la estructura exterior y paredes interiores 

Antes de empezar a construir, configuramos el Grid a través de la pestaña Settings > 

Global Settings, seleccionando la casilla Grid y colocando el tamaño en Grid Size deseado, 

en nuestro caso usaremos un grid de tamaño 0.1 m, como se ha visto en pasos anteriores. 

Utilizaremos el botón Add Objects Orthogonal y, situando el cursor en las guías del 

plano, empezaremos a realizar la colocación de las paredes. Teniendo en cuenta que el valor por 

defecto de la construcción es de 30cm en ladrillo (Figura 29), empezaremos colocando 

únicamente las paredes exteriores y aquellas interiores que tengan el mismo grosor y material 

[Anexo IV]. 

Una vez llegados a este punto guardaremos una copia del proyecto para realizar a posteriori 

una simulación solamente con las paredes exteriores y poder realizar una comparación con una 

simulación con todas las paredes, ventanas, puertas y columnas de la zona. 
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Una vez hayamos colocado los muros exteriores y todos aquellos que concuerden con el 

material ladrillo de 30 cm de grosor, pasaremos a colocar las paredes interiores. Para ello primero 

deberemos configurar el nuevo material. Iremos a Edit > Default Values y allí escogeremos 

en nuevo tipo de material para los nuevos muros, en nuestro caso para la configuración de las 

paredes del pasillo utilizaremos ladrillo de 20 cm. 

Una vez construidas las paredes del pasillo, realizaremos la construcción de las paredes 

divisorias de los despachos. Para éstas utilizaremos el material pladur con un grosor de 10 cm, 

que es aproximadamente el utilizado para la construcción del edificio. Para seleccionar dicho 

material realizaremos de nuevo la configuración de los valores por defecto y volveremos a 

construir las paredes siguiendo el plano. 

3.1.3. Colocación de puertas y ventanas 

Tras finalizar la construcción de las paredes, tanto interiores como exteriores, el siguiente 

paso es colocar puertas y ventanas. Para ello empezaremos colocando las puertas. Iremos a Edit 

> Default Values y seleccionaremos la opción Upper and lower coordinate, tal y 

como se ve en la Figura 34, colocando la coordenada inferior en 0 (a ras de suelo) y la coordenada 

superior en 3.5m. Seleccionando esta vez el material en el apartado Subdivisions. 

 

 
Figura 34: Valores por defecto de los nuevos materiales para la construcción de puertas 
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Figura 35: Puertas de los despachos de ingeniería 

 

En nuestro caso, en el momento de realizar la colocación de las puertas, debemos tener en 

cuenta que las puertas de los despachos contiguos están unidas por el propio marco de la puerta 

que también es de madera, por lo que hay que colocar el material de madera desde el inicio de 

una puerta hasta el final de la contigua (Figura 35). 

Colocaremos las puertas con la misma herramienta que los muros. En el momento de colocar 

la puerta el programa nos preguntará qué queremos hacer realmente con la subdivisión, 

deberemos seleccionar Create a subdivisión > Subdivision with individual 

material properties. Se nos creará en el lugar dónde hemos colocado la puerta una línea de 

color morado indicando la ubicación de la subdivisión. Repetimos el proceso con todas las puertas 

y a continuación pasamos a colocar las ventanas. 

Para colocar las ventanas repetiremos el proceso de configuración, pero esta vez situaremos 

las coordenadas Min y Max de 0.5 a 3.5 para las ventanas de la sección norte del edificio y para 

las ventanas de los despachos de la parte sur de 1.5 a 3 con material de vidrio de 5 mm de grosor. 

Ahora, cuando coloquemos las ventanas, no se nos serán visibles en el plano de WallMan. 

Eso es debido a que nos está representando la 3ª coordenada en la posición 0. Por lo tanto, como 

las ventanas se sitúan en este caso en una altura de 0.5m, no aparecerán visibles en el plano. Para 

que las ventanas aparezcan visibles situaremos la 3ª coordenada a través del botón 3rd 

Coordinate Settings y, en la ventana que se nos abre, colocaremos el cursor en el valor de 

1.6m (Figura 36). 

 

 
Figura 36: Configuración de la 3a coordenada 
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3.1.4. Columnas y escaleras 

A continuación, añadiremos las columnas presentes en el pasillo de la rama de despachos. 

Antes de agregarlas, nos aseguraremos de que la 3ª coordenada se encuentra en 0m para el plano 

XY ya que sino estaríamos situando la columna a una altura superior al suelo. Para ello nos iremos 

a la herramienta Create Cylinder en la barra superior de herramientas LEGO. Se nos abrirá 

una ventana de configuración. Lo que queremos construir en nuestro caso es una columna de unos 

22 cm de radio de hormigón. El programa, en el momento de emular una columna, realiza una 

aproximación con un polígono. En nuestro caso es suficiente crear una columna a través de un 

octágono, por lo que introduciremos un numero de córneres de 8, una altura de 4 metros y un 

radio de 0.22 m. Configuraremos las propiedades de la columna a través del botón Material… y 

allí seleccionaremos Hormigón de 10 cm (Concrete) tal y como se observa en la Figura 37. Una 

vez pulsamos OK seleccionamos el lugar dónde ubicar nuestra columna con clic izquierdo y 

confirmamos dándole a clic derecho en el ratón. Repetimos el proceso para todas las columnas 

que queramos añadir.  

 
Figura 37: Creación de una columna de hormigón 

 
Figura 38: Configuración de las escaleras 
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A continuación, realizaremos la construcción de las escaleras del piso 1 al piso 2. Para ello 

utilizaremos la herramienta Create Stairs de la barra de herramientas LEGO. Al abrir la 

herramienta, se nos abre una ventana con las configuraciones para tener en cuenta para la creación 

de la escalera (Figura 38). En ella especificaremos los siguientes valores siguiendo el esquema de 

la figura. 

• hSt: altura del escalón. En nuestro caso la altura medida es de 17 cm. 

• dSt: profundidad del escalón. En el caso de las escaleras de ingeniería se trata 

de 30 cm. 

• wSt: ancho del escalón. En nuestro caso de 1.8 metros. 

• nSt: número de escalones. 12 en el caso de estas escaleras. 

• hSo: el ancho de la viga que sujeta los escalones. En este caso de unos 20 cm. 

• 3rd coordinate offset: sirve para señalar al programa a que altura respecto el 

suelo se encuentra, en este caso y en la mayoría de ellos, pondremos 0. En 

material escogeremos hormigón (concrete) 

 

Una vez configurado pulsaremos OK y ubicaremos en el mapa la coordenada del primer 

escalón. Una vez fijado el primer escalón deberemos ajustar el resto de la escalera. Para 

comprobar que la escalera se ha colocado correctamente, podemos utilizar la vista en 3D o la vista 

en Y/Z. 

 

 
Figura 39: Vista Y/Z de la escalera creada con WallMan 

 

Para ajustar la visión correcta de la escalera en la vista Y/Z seleccionaremos dicha vista e 

iremos al botón de la tercera coordenada y ajustaremos el valor de ésta hasta poder observar la 

escalera en la vista Y/Z (Figura 39). 

A continuación, crearemos el entresuelo de la escalera y la segunda parte de la escalera. Para 

crear la segunda parte de la escalera repetiremos el proceso, pero esta vez colocaremos el offset 

de la 3ª coordenada en 2 metros. 

Si reajustamos la vista en el plano Y/Z veremos cómo ha quedado el segundo tramo de la 

escalera. Es posible que la escalera haya quedado en sentido contrario, en caso de que sea así, la 

reajustaremos usando la herramienta de rotación. Para ello seleccionaremos la escalera e iremos 

a la pestaña Objects > Rotate Selected Objects. Allí se nos abrirá una nueva ventana 

como la de la Figura 40 dónde seleccionaremos que nos haga una rotación en el eje Z de 180º. 

Seleccionaremos OK y podremos ver como se nos ha girado 180º colocándose en la posición 

correcta (Figura 41). 
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Figura 40: Ventana de rotación de objetos 

 
Figura 41: Parte de las vistas Y/Z y 3D de WallMan con las escaleras y el entresuelo. 
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Para colocar el entresuelo de la escalera situaremos la 3ª coordenada en el plano X/Y a 2 

metros y seleccionaremos la herramienta Add Poligonal Objects de la barra izquierda. 

Dibujaremos el entresuelo de la escalera y finalizaremos el dibujo haciendo clic derecho en el 

ratón. Seleccionaremos el entresuelo y haremos clic derecho > Material Properties 

para asegurarnos que el material con el que se ha construido el suelo es cemento de un grosor de 

30 cm (concrete). Observando la figura en 3D y el plano Y/Z deberíamos ver la escalera con el 

entresuelo bien colocado (Figura 41). 

Una vez hayamos finalizado la construcción de la base de datos en WallMan, guardaremos 

la base de datos. 

 

3.1.5. Colocación del suelo y del tejado 

Por último, debemos colocar el tejado y el suelo de nuestra estructura. Para ello 

seleccionaremos la herramienta Add Poligonal Objects de la barra de herramientas izquierda 

y dibujaremos el suelo. Antes de dibujar, debemos asegurarnos de que la 3ª coordenada se 

encuentra en 0 metros. Una vez dibujado seleccionaremos el suelo creado, daremos clic con el 

botón derecho e iremos a Material Properties… para asegurarnos que el material utilizado 

es cemento a grosor de 30 cm. 

Una vez asegurado, seleccionaremos el suelo, daremos clic derecho del ratón y 

seleccionaremos Copy. Colocaremos la 3ª coordenada a 4 metros y pulsaremos la combinación 

Ctrl+V para colocar el tejado de la estructura A continuación, manteniendo la 3ª coordenada en 

4 metros, vamos a realizar una apertura para la planta superior en la zona de la escalera que 

anteriormente habíamos creado. Para ello seleccionaremos la herramienta Add Rectangular 

Objects y realizamos un rectángulo sobre las escaleras. En la ventana que se nos abrirá 

seleccionaremos Create a subdivisión >> Hole in surrounding wall para abrir una 

apertura en el tejado. Podemos comprobar que esté todo correcto a través de la vista 3D (Figura 

42). 

 
Figura 42: Plano X/Y y vista 3D de la base de datos en WallMan construida. 
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3.1.6. Preprocesado en WallMan 

En este subapartado realizamos el preprocesado de la base de datos. El preprocesado permite 

al programa analizar la base de datos y dividirla en mosaicos para ahorrar coste computacional en 

la simulación final mediante ProMan. 

Para realizar el preprocesado de nuestra database, primero de todo cerraremos la actual 

database una vez guardada. Iremos a File > New Project. Seleccionaremos la database que 

hemos guardado anteriormente y la abriremos. Iremos a la pestaña Preprocessing > Edit 

Preprocessing Parameters. Especificaremos en Output un nombre diferente al que hemos 

utilizado para la base de datos. Seleccionaremos 3D IRT y seleccionaremos como área a predecir 

toda (Figura 43). 

 
Figura 43: Configuración del preprocesado. Pestaña Main 

 

Iremos a la pestaña Advanced, allí seleccionaremos el tamaño mínimo para la difracción, 

pondremos el valor de 0.1. Este tamaño de 0.1 equivale a la longitud mínima a considerar para 

las difracciones en la simulación, teniendo en cuenta que la zona más pequeña equivale al pasillo 

(de unos 2 metros) una longitud de 10 cm es suficientemente pequeña para que sea considerada. 

Considerar longitudes menores no provocaría una gran mejora en la precisión y generaría un coste 

computacional mayor. 

En la pestaña IRT General especificaremos una resolución de grid de 0.1 metros, lo que nos 

dará una resolución en la simulación de 10 cm (Figura 44). En la pestaña de IRT Acceleration 

simplemente cambiaremos el valor de Max. Cores/CPUs y seleccionaremos todas aquellas que 
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queramos usar, lo suyo es usar todas las que el PC tenga disponibles para minimizar el tiempo de 

cálculo (Figura 45). 

Clicaremos en OK, guardaremos el proyecto mediante File > Save Project As… Iremos 

a Preprocessing > Compute Current Project y dejaremos que WallMan realice el pre-

procesado del proyecto. Una vez finalizado el pre-procesado cerraremos WallMan y abriremos 

ProMan.  

 
Figura 44: Configuración del preprocesado. Pestaña advanced 

 

 
Figura 45: Configuración del preprocesado. Pestaña IRT Acceleration 
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3.2. ProMan 
A continuación, configuraremos ProMan para poder realizar la simulación del escenario 

principal. Para ello abriremos el ProMan e iremos a File > New Project. Y seleccionaremos 

el proyecto pre-procesado que hemos realizado con WallMan. El resto de los parámetros los 

configuraremos a nuestro gusto como vimos anteriormente en el capítulo 2. 

 

3.2.1. Configuración del router 

Una vez abierto el plano, seleccionaremos la herramienta Set Site en la barra izquierda y, 

en la ventana que se nos abrirá, seleccionaremos la antena Site 1 Antenna 1. En esa ventana 

configuraremos la celda como nuestro router, a una frecuencia de 2.4 GHz a 20 dBm de PIRE y 

una altura respecto el suelo de 3.8 metros. En Antenna Pattern escogeremos la antena 

proporcionada por FEKO y la colocaremos con un ángulo Azimuth de 180º (en el techo mirando 

al suelo) (Figura 46). Podemos renombrar las antenas para facilitar su identificación en los 

resultados. Crearemos una antena que llamaremos QC/1007 y una segunda llamada QC/1027, 

correspondiendo al despacho en las que se encuentran ubicadas. 

Pulsamos OK cuando hayamos finalizado la configuración de la antena. 

 

 
Figura 46: Configuración de la ubicación del Router en ProMan 

 

3.2.2. Configuración de los parámetros 

Nos dirigimos a la pestaña Project > Edit Project Parameters y en la ventana que 

se nos abre configuramos los parámetros de simulación. En la pestaña Simulation podemos 

escoger un tamaño personalizado del área a simular, en este caso lo dejaremos tal cual está. En la 

pestaña Propagation seleccionaremos el Field Strength para comprobar la potencia del router 

y su propagación por el plano (Figura 47). 
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Figura 47: Pestaña Propagation de los parámetros de simulación de ProMAN 

En las pestañas Sites, Components y Database no tocaremos nada y nos dirigiremos a la 

pestaña Computation. En ella haremos clic en Settings para el 3D Ray Tracing IRT y 

configuraremos los parámetros como los de la Figura 48, en esta pestaña, se pueden cambiar los 

parámetros presentes acorde con lo que deseamos obtener en nuestra simulación, en este caso, 

con un número máximo de 8 transmisiones, 2 reflexiones y 2 difracciones es suficiente para poder 

obtener el trazado de la señal desde el router hasta el punto marcado que posteriormente 

obtendremos en el visualizado de resultados. Consideramos dichos valores, debido a que los paths 

que se puedan calcular con más reflexiones no nos aportarán mayor resolución ni mejores 

resultados y generarán un coste computacional mucho mayor. En esa misma pestaña nos 

aseguramos de que tengamos seleccionados los Coeficientes de Fresnel para realizar la simulación 

(Figura 49) y damos clic en Aceptar. Utilizamos los coeficientes de Fresnel, porque nos 

devuelven una mejor precisión de los resultados al ser un método determinista. 

Realizamos la simulación a través de la pestaña Computation > Propagation: 

Compute all. Una vez finalizada la simulación observaremos los resultados. 

 

3.2.3. Visualización de resultados 

Una vez finalizada la simulación podremos observar los resultados de las potencias de 

nuestro router en el propio plano de simulación. Para ver los resultados iremos a la columna de la 

izquierda, seleccionaremos Results: Propagation >> Router 1 >> Site 1 Antenna 

1 >> Power. Nos aparecerá en el plano la potencia del router tal y como podemos observar en 

la Figura 50. 

A la derecha de la pantalla podemos observar una leyenda de los valores proporcionados por 

ProMan. Como no nos interesa representar un margen dinámico tan grande, vamos a cambiar la 

configuración para poder visualizar mejor los resultados. Para ello haremos clic derecho sobre la 

leyenda e iremos a Settings… En la ventana Settings seleccionaremos User-defined 

thresholds y haremos clic en el botón Change. Allí nos fijaremos únicamente en el apartado 

Continuous scale y cambiaremos el valor del rango mínimo por -85, los valores inferiores a 

-85 dBm serán ignorados (Figura 51). Pulsaremos en OK y después en Aceptar y podremos 
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observar los cambios producidos en la presentación de los resultados (Figura 52). Las zonas que 

aparecen en transparente en determinados puntos del mapa son relativas a las zonas en las que la 

potencia que llega del router se encuentra por debajo de los -85 dBm de potencia. 

Si seleccionamos la herramienta Ballon tip podemos observar el valor de la potencia allí 

dónde situemos el cursor del ratón para así poder tomar nota de determinados puntos y observar 

las coherencias o incoherencias que se detecten (Figura 52). 

 

 
Figura 48: Parámetros de configuración de IRT 

 

 
Figura 49: Pestaña Computation de los parámetros de configuración. Apartado de Fresnel. 
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Figura 50: Potencia del router en el plano XY del edificio de ingeniería. 

 

 

 

 
Figura 51: Configuración del escalado de visualización de la potencia. 
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Figura 52: Herramienta Ballon tip en el plano de propagación de ProMan 

 

3.3. Discusión de resultados preliminares 

Si analizamos los resultados del apartado 3.2, podemos observar como la señal dentro de los 

despachos es de unos 10-15 dB inferior a la que hay presente en el pasillo (Figura 52). 

Comparando la potencia en los diferentes espacios del plano, obtenemos unos valores de -37 dBm 

aproximadamente en los despachos más juntos al router y unos valores de unos -65 dBm para 

aquellos que ya se sitúan más a lo lejos del router. 

En la Figura 52 también podemos observar la diferencia de señal que pasa hacia los 

despachos cuando atraviesa la puerta de madera en vez de la pared de ladrillos dónde el nivel de 

potencia es superior a las zonas que quedan detrás de las paredes de ladrillo. Se puede observar 

en la Figura 53, una zona más oscura en la parte trasera a las puertas. 

 
Figura 53: Figura 52 ampliada en la ubicación cercana a dos puertas de madera. 
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En esta misma Figura 53 también podemos observar la pérdida de señal en la zona que queda 

oculta tras la columna. Podemos ver como hay una pérdida de unos 10-15 dB de potencia en las 

zonas que quedan ocultas detrás de la columna junto con el muro de ladrillo. También observamos 

como cada vez que atraviesa una pared de pladur, decae la potencia entre 5-10 dB. 

¿Qué pasaría si el router en vez de estar ubicado justo en frente de la columna estuviera 

ubicado entre las dos? En el siguiente apartado compararemos diferentes escenarios, entre ellos, 

un cambio de ubicación en el router. 

 

3.4. Comparación de escenarios 

En este apartado vamos a analizar diferentes escenarios para posteriormente compararlos 

entre sí. Utilizando el mismo método de simulación en todos los casos. El primer escenario que 

vamos a analizar es del apartado 3.1 en el que se guardaron solamente las paredes exteriores del 

edificio. Colocaremos un router en la misma ubicación que el analizado en el apartado anterior y 

con los mismos parámetros. 

 

 
Figura 54: Propagación de la señal en el plano sin paredes interiores. 

 

Utilizando la herramienta Line Plot, vamos a crear una línea en la que ProMan realizará un 

análisis de potencia de nuestro router. La línea se sitúa desde la propia ubicación del router hasta 

20 metros a la derecha de éste siguiendo la Figura 54. 

Si analizamos el gráfico de la Figura 55, podemos ver un detalle curioso, y es que el pico de 

potencia no se produce en los 0 metros, sino en los 2 metros. Esto es debido a que el router se 

encuentra justo en el techo y nosotros estamos realizando el análisis a 1.5 metros del suelo, por 

lo tanto, nos estamos situando debajo del router, justo en el nulo del diagrama de radiación de 

éste. 
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Figura 55: Gráfica de potencia del router en el escenario de la Figura 54. Desde el punto inicial hasta 20 metros de 

distancia en dirección horizontal sentido derecho del plano. 

Si analizamos la potencia que disponemos en el punto a 5 metros del router, obtenemos una 

cantidad de -28 dBm de potencia. Según la teoría de propagación en espacio libre, cada vez que 

se dobla la distancia perdemos 6 dB, por lo tanto, a 10 metros del router deberíamos obtener unos 

-34 dBm de potencia. Sin embargo, si situamos el cursor a los 10 metros del router obtenemos 

una potencia de aproximadamente -31 dBm. Este resultado no significa que el programa no se 

adapte al espacio libre, sino que no nos encontramos realmente en un escenario con espacio libre 

real. Ya que tenemos el techo y el suelo que nos generan rebotes. 

A continuación, vamos a analizar el escenario del apartado 3.2 con el cambio de ubicación 

del router, para observar las diferencias que se producen en cuanto a la pérdida que nos genera la 

columna. En el escenario del apartado 3.2, si nos fijamos en la Figura 53 vemos como hay una 

gran pérdida provocada por la columna. Si creamos una gráfica como la anterior realizando un 

recorrido por esa columna, podremos ver con mayor detalle la pérdida añadida por ésta. 

Si observamos la gráfica de la Figura 56 y observamos el recorrido de ésta, desde el inicio 

del router hasta el final del despacho QC/1013 (zona izquierda del despacho) pasando por la 

columna, vemos como la potencia cae drásticamente cuando la línea pasa por encima de la 

columna, provocando una pérdida de 10 dB. 

Para observar que diferencias habría en el caso de haber colocado el router en otra ubicación, 

por ejemplo, entre las dos columnas, hemos realizado un cambio en ProMan de la ubicación del 

router utilizando la herramienta Site: Move de la barra de la izquierda. Lo recolocaremos en la 

nueva ubicación entre las dos columnas. Si realizamos una nueva simulación para la nueva 

ubicación manteniendo la configuración, obtendremos los siguientes resultados (Figura 57). 

Ubicando el router entre las dos columnas mejoramos mucho la señal presente en los 

despachos que hay justo en frente de la nueva ubicación. Para comparar el resultado, vamos a 

crear una nueva gráfica con el mismo recorrido que el anterior, pero con la nueva ubicación del 

router. 

Para tener una mejor visión de lo que nos ofrece el gráfico de la Figura 58, en la Figura 59 

se observa la línea que ha analizado la gráfica de la Figura 58. 
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Figura 56: Gráfica de potencia del router en el escenario de la Figura 52. Desde el punto inicial hasta 9 metros de 

distancia en dirección abajo. 

 

 

 
Figura 57: Resultados con la nueva ubicación del router, ubicado entre las dos columnas. 
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Figura 58: Gráfica de potencia del router en el escenario de la Figura 57. Desde el punto inicial hasta 9 metros de 

distancia en dirección vertical sentido hacia abajo. 

 

 

Figura 59: Recorrido analizado por la gráfica de la Figura 56 y la gráfica de la Figura 58. 

 

Visualizando los datos de la Figura 58, los primeros 2 metros equivalen a la potencia 

disponible en el pasillo. Cuando se traspasa la pared de pladur se puede ver como la potencia 

queda decrementada en aproximadamente 5 dB y a continuación vuelve a verse incrementada 

debido a la diferencia de la puerta de madera, cuya propagación por dicho medio es mejor que la 

de pladur. 

 Sin embargo, con dicha configuración, el despacho que anteriormente estaba en frente del 

router ha visto decrementada bastante el nivel de señal que le llega respecto a la potencia anterior. 

Viendo los resultados, el caso del escenario del 3.2 es mejor que la simulada en la Figura 57 ya 

que a la izquierda del plano tenemos la zona de las escaleras y el ascensor y no hay ubicado ningún 
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router hasta el siguiente pasillo, por lo que el despacho QC/1005 tendría un nivel de potencia muy 

bajo. Por lo tanto, es mejor mantener la configuración simulada en el 3.2 en el que permitimos 

que haya mayor nivel de potencia a cambio de tener una “zona muerta” en la zona de detrás de la 

columna. 

Si realizamos una comparativa con el Linear Plot pasando por el medio del despacho 

QC/1005, obtendremos las gráficas de la Figura 61 dónde veremos claramente la diferencia de 

potencia de los escenarios de la Figura 60. 

 
Figura 60: Potencia en los despachos QC/1005 y QC/1009 con el router en la ubicación simulada (izquierda) y en la 

ubicación real (derecha) 

 
Figura 61: Gráficas de la potencia propagada en el despacho QC/1005 siguiendo la Figura 60. A la izquierda, la 

potencia del despacho QC/1005 con la nueva configuración del router, a la derecha, con la ubicación real. 

 

Si analizamos la Figura 61, podemos ver de inicio la diferencia en la escala. La máxima 

potencia obtenida en la simulación del apartado 3.2 es de unos -35 dBm mientras que en esta 

última simulación es de aproximadamente -42 dBm. Si analizamos el valle que se ve en la gráfica 

izquierda y lo comparamos con los resultados de la Figura 60, vemos que la columna nos crea 

una zona de sombra que podemos visualizar de color turquesa. 

Viendo los resultados, se puede concluir que, manteniendo el número de routers a colocar, 

la configuración real es mejor a la nueva ubicación con el router en medio de las dos columnas. 

Sobre todo, teniendo en cuenta, la potencia que le llega al despacho QC/1005. 
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3.5. Comparación de modelos y métodos 
3.5.1. Modelos SRT y MWM 

Ahora que ya hemos realizado una simulación del escenario, vamos a repetir el proceso con 

un par de métodos para posteriormente compararlos entre ellos. Se va a realizar una simulación 

utilizando el método Multi Wall Model (MWM) y el método Standard Ray Tracing (SRT), ambos 

con las ecuaciones de Fresnel (método determinista). 

El método MWM, tal y como hemos visto en el capítulo 2, realiza un cálculo de la pérdida 

del rayo considerando los materiales de la construcción, mientras que SRT realiza una predicción 

rigurosa del trazado 3D de los rayos. 

 
Figura 62: Antena QC/1007 modelo MWM con Fresnel. 

 
Figura 63: Antena QC/1007 modelo SRT con Fresnel. 
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Si observamos los resultados de la Figura 62 y la Figura 63 podemos ver a simple vista como 

en el caso de la Figura 63 la distribución de la señal es mucho más irregular a la distribución de 

la Figura 62. Esto es principalmente debido a que, tal y como hemos visto anteriormente, SRT 

realiza una predicción del trazado 3D teniendo en cuenta reflexiones, refracciones, difracciones, 

etc… Por ende, el resultado visible en la Figura 63 dispone de una mayor precisión y adaptación 

a la realidad. 

A continuación, utilizaremos la herramienta de ProMan Substract Data para hacer una 

comparación de potencias entre un modelo y otro, restando el resultado de MWM a SRT. Para 

ello iremos al resultado de SRT y mediante Edit > Substract Data > Value (File, linear) 

seleccionaremos el archivo de resultados MWM. El resultado por pantalla será el sustrato de SRT 

con MWM. Reajustaremos la escala de la leyenda para poder visualizar mejor los resultados y 

obtendremos la Figura 64. 

 
Figura 64: Sustrato del resultado MWM a SRT. 

Visualizando los resultados de la Figura 64, podemos ver que los lugares donde hay mayor 

discrepancia de resultados se encuentran en las zonas de detrás de las columnas, dónde SRT nos 

ofrecía hasta 15 dB más de potencia respecto al método MWM. Esta diferencia de resultados es 

debido a esa interacción que realiza SRT con las reflexiones, proporcionando mayor nivel de señal 

en las zonas ocultas a la visión directa. 

 

3.5.2. SRT: método deterministra (Fresnel) y método empírico. 

Ya hemos visto una comparación entre los modelos MWM y SRT, ahora vamos a centrarnos 

en el modelo SRT y vamos a comparar los métodos de Fresnel con los empíricos. 

Como hemos visto en el capítulo 2, el método de Fresnel es un método determinista que 

utiliza el GTD/UTD para las pérdidas por difracción, mientras que el modelo empírico utiliza los 

cinco parámetros para calcular su valor. Pero ¿cómo se traduce este párrafo en los resultados 

obtenidos? 

Vamos a reutilizar la herramienta del apartado 3.5.1 para ver directamente la diferencia entre 

el método de Fresnel y el método empírico. 
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Figura 65: Resultado de la antena QC/1007 con el modelo SRT. Sustracción del método empírico al método de 

Fresnel. 

 

Como podemos ver en la Figura 65, el método de Fresnel ofrece un resultado con mayor 

nivel de potencia en las zonas en las que el escenario es más irregular (detrás de la columna, junto 

a las paredes ocultas, etc…), como bien se ha explicado en el capítulo 2, esa diferencia es debida 

al uso de las ecuaciones de Fresnel aplicadas a las pérdidas y el principio de GTD/UTD, junto 

con los parámetros de permitividad, permeabilidad y conductividad de los materiales, que 

complementan los resultados obtenidos. 

 

3.6. Discusión de resultados 

Una vez obtenidos los resultados, podemos compararlos entre ellos, viendo como todos los 

métodos utilizados en este capítulo, difieren en zonas conflictivas mayoritariamente (como las 

columnas o zonas ocultas). Si nos fijamos en la Figura 64 en la que se comparan los métodos 

MWM y SRT, en la mayor parte del plano su diferencia es de unos ±5 dB, por lo que, en este tipo 

de aplicaciones, el hecho de utilizar un método u otro no varía mucho. Sin embargo, hay que tener 

en cuenta el coste computacional de cada uno de los métodos antes de escoger el mejor 

dependiendo de la aplicación que se desee. 

Utilizando el método MWM, la simulación ha tardado en ejecutarse aproximadamente 1 

minuto, mientras que el método SRT se ha ejecutado en 1 hora y 15 minutos. Esta diferencia de 

tiempo se debe a que SRT tiene en consideración todas las interacciones del rayo, mientras que 

MWM utiliza la ecuación vista en el Capítulo 2 para realizar sus cálculos. 

Viendo esta diferencia de tiempos y la variación en los resultados, podemos concluir que, 

para realizar una predicción preliminar, utilizar el método MWM es suficientemente aproximado. 

Si comparamos la diferencia de tiempo entre utilizar el método empírico o el determinista 

con las ecuaciones de Fresnel, la diferencia de tiempo computacional no es determinante y ofrece 

mejores resultados el método de Fresnel. 
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Por lo tanto, como conclusión de este apartado podemos decir que, si nuestra intención es 

comprobar qué cobertura nos llegará a ciertas zonas, utilizar modelos rápidos como MWM es un 

método correcto de aproximar la potencia de la señal en las zonas del plano que, pese a no tener 

en consideración la reflexión de los rayos, obtienen buenos resultados en comparación con 

modelos más completos como el SRT.  
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CAPÍTULO 4: MEDIDAS EXPERIMENTALES 

En este capítulo vamos a comparar un par de herramientas de medidas de potencia de la señal 

Wi-Fi que posteriormente utilizaremos para realizar mediciones de la señal del router QC/1007 

del Capítulo 3 y comparar las medidas obtenidas con las herramientas con los valores obtenidos 

en las simulaciones de WinProp. 

 

4.1. Herramientas de medida 
4.1.1. NetSpot 

La primera herramienta que vamos a analizar es NetSpot[23], un aplicativo para monitorizar 

las redes inalámbricas y el análisis Wi-Fi. Lo analizaremos en su versión Windows gratuita, que 

ofrece la capacidad de ver el nivel de potencia proveniente del router Wi-Fi que deseemos (Figura 

66). 

El programa en su versión gratuita nos ofrece una gráfica temporal con el nivel de la señal 

del router (Figura 67) y un seguido de columnas en su interfaz principal (Figura 66) con el nivel 

de señal recibido, el mínimo y máximo junto con un promedio. Los resultados de las columnas se 

encuentran en dBm. 

En su versión gratuita no nos permite crear un plano mediante medidas en determinados 

puntos ni exportar los datos de la gráfica, sin embargo, nosotros podemos realizar dicho plano 

manualmente mediante el cálculo del nivel de potencia en determinados puntos para poder 

compararlos con los resultados de WinProp. 

Tal y como podemos observar en las diferentes columnas de la Figura 66, el programa ofrece 

un valor de señal sin decimales, por lo que la tolerancia de éste se reduce a ±1 dB 

 

 
Figura 66: Interfaz del programa NetSpot en Windows 10. 
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Figura 67: Gráfica temporal del nivel de señal del router vodafone856C 

 

4.1.2. WiFi Analyzer 

El segundo programa que vamos a utilizar es una aplicación gratuita de Android llamada 

Wifi Analyzer[24]. 

 
Figura 68: WiFi Analyzer. Pestaña Gráfico de canales (izquierda) y lista de AP (derecha) 
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Figura 69: WiFi Analyzer. Pestaña Gráfico de tiempo (izquierda) y Medidor de señal (derecha) 

Wifi Analyzer, al igual que NetSpot, nos ofrece una lista con los diferentes puntos de acceso 

WiFi y el nivel de señal que nuestro dispositivo móvil recibe (Figura 68 - derecha) y una gráfica 

temporal con el nivel de señal de todas las redes disponibles (Figura 69 - izquierda). A parte de 

esas dos herramientas también nos ofrece una gráfica de canales dónde se distribuyen los puntos 

de acceso (Figura 68 - izquierda) y un medidor de señal para una red específica (Figura 69 - 

derecha). 

 

4.2. Comparación de herramientas 

En este apartado vamos a realizar un pequeño análisis del funcionamiento de ambas 

herramientas y compararlas entre sí. La finalidad es ver en qué se diferencian o, en caso contrario, 

su similitud. 

Para realizar la comparación, se ha colocado el portátil y el teléfono móvil en la misma 

ubicación durante un periodo de tiempo y se ha dejado que las aplicaciones almacenaran 

información. 

Una vez recibida la información, podemos compararla visualizando la lista de redes WiFi en 

ambas aplicaciones. Si observamos la Figura 66 en NetSpot y la Figura 68 en Wify Analyzer, 

centrándonos en la red “vodafone856C”, red a la que ambos dispositivos estaban conectadas, 

podemos ver como el nivel promedio de potencia que nos devuelven ambas aplicaciones es de -

52 dBm. Por lo que podemos concluir, que ambas aplicaciones funcionan de un método similar a 

la hora de calcular el nivel de potencia recibido. Si nos fijamos en otras redes, los resultados 

varían en pocos dB, por lo que se puede concluir, teniendo en cuenta que el entorno en el que se 

han analizado dichos programas no es un entorno perfecto y tiene un canal muy variable, que 

ambos proporcionan una información aproximada de los puntos de acceso WiFi del entorno. 
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4.3. Medidas experimentales 

A continuación, se exponen los resultados de las medidas experimentales, utilizando el 

programa NetSpot, comparadas con los modelos Multi-Wall (MWM) y Standard Ray Tracing 

(SRT), utilizando el método determinista (Fresnel) en ambos casos. 

Se ha realizado una planificación previa de puntos clave a comparar entre las simulaciones 

y las medidas reales siguiendo el esquema de la Figura 70. En la tabla de a continuación, se 

recogen los datos obtenidos mediante NetSpot y los obtenidos en MWM y SRT en el mismo punto. 

La referencia de coordenadas es la proporcionada por WinProp. Las medidas experimentales se 

han realizado colocando un portátil con el programa NetSpot en un carro para poder medir 

siempre desde la misma altura y desplazando éste a los puntos marcados en la Figura 70. 

Antes de analizar los datos obtenidos se deben tener las siguientes consideraciones: 

- El router utilizado en WinProp es un modelo cuya directividad puede no ser la misma 

que el router original, aunque si será bastante aproximada. 

- La potencia de emisión del router puede no tener la misma potencia de transmisión a la 

estipulada en WinProp de 20 dBm de PIRE. 

- El router del campus emite la señal de la UAB y Eduroam desde el mismo punto de 

acceso, por lo que WinProp no tiene en consideración las posibles interferencias entre 

ellas. 

-  Para obtener el mejor resultado en las medidas experimentales, se ha realizado un 

cálculo promedio de varias iteraciones que NetSpot calcula. Recogidas todas en el Anexo 

IV. Cabe remarcar que NetSpot tiene una tolerancia de 1 dB. 

 

 
Figura 70: Esquema de planificación de las medidas realizadas. 
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Si comparamos los diferentes resultados de la tabla, podemos encontrar variaciones que van 

desde uno o dos dB hasta los 22 dB, como es el caso del punto 11, en el que NetSpot nos da un 

valor medio de -60.4 dBm y la simulación por WinProp nos ofrece unos -42 dBm en MWM y -

38.5 dBm en SRT. Si analizamos el punto medido, se trata de uno situado bastante lejos del router 

y parcialmente oculto por una columna. SRT nos proporciona el valor más optimista, eso es 

debido a que tiene en cuenta todas las iteraciones que se producen con los objetos, el problema lo 

tenemos en el hecho de que en el plano diseñado en WallMan no se han colocado todos los objetos 

que hay en la construcción, por lo que el programa no los podrá considerar y sus efectos serán 

ignorados. Otro de los posibles motivos de esta gran diferencia puede ser provocado por una 

errónea consideración de NetSpot en el momento de realizar el cálculo, o de alguna interferencia 

destructiva que se produzca en ese punto y que WinProp no ha tenido en cuenta debido a las 

consideraciones anteriormente nombradas. 

A excepción del punto 11, el resto de los puntos tienen una diferencia de unos 10 dB máximo 

y siguen un trayecto bastante similar. Si analizamos los diferentes sub-escenarios presentes, 

podemos ver que la simulación que mejor se adapta a los resultados obtenidos en la campaña de 

medidas para el interior del despacho QC-1013 es el modelo SRT, que de media tiene menor 

diferencia comparado al modelo MWM. Podemos ver también como en la parte más alejada del 

pasillo, tanto MWM como SRT no se adaptan tanto a los valores medidos. Cabe tener en 

consideración, que en los escenarios simulados no se ha tenido en cuenta los armarios, pizarras y 

archivadores, éstos dos últimos metálicos, que pueden aportar efectos notables de reflexión y 

dispersión. 

Podemos concluir que el método MWM se adapta mejor en las zonas donde no hay gran 

cantidad de obstáculos mientras que SRT modela mejor esa interacción de la señal con los 

diferentes obstáculos presentes en la base de datos, volviendo a remarcar que, en la base de datos 

simulada, no hay objetos ni obstáculos considerados. 
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CAPÍTULO 5: CONCLUSIONES 

5.1. Conclusiones 

Un programa de simulación y análisis de propagación de redes electromagnéticas es una 

herramienta muy útil en el momento de realizar una planificación de una red de 

telecomunicaciones. La planificación de una gran estructura de telecomunicaciones es clave para 

evitar problemas futuros en cuánto a la cobertura del servicio, pérdida de señal e inclusive 

conflictos con otros servicios. Herramientas como WinProp, ofrecen un gran abanico de 

programas y modelos que permiten realizar este tipo de planificación antes de realizar la 

construcción del sistema de telecomunicaciones y nos permite ahorrar mucho tiempo comparado 

con la aplicación de modelos teóricos. 

Durante el Capítulo 2, se ha podido comprobar la diferencia entre los modelos que realizan 

un análisis preliminar de la estructura, ofreciendo únicamente la atenuación sufrida por la señal y 

los métodos que interactúan con el medio para ofrecer unos resultados más precisos y detallados. 

Para la realización de una planificación básica sobre la cobertura WiFi en un edificio, hemos 

podido examinar como con métodos básicos, el programa ofrece una aproximación útil para una 

correcta planificación sin necesidad de invertir muchos recursos computacionales. 

En el Capítulo 3, este proyecto ha analizado el funcionamiento del programa WinProp 

aplicado al análisis del edificio de la Escuela de Ingeniería. Los resultados han mostrado como 

los métodos deterministas ofrecen un mejor resultado sobre los métodos empíricos con poca 

diferencia en cuanto al coste computacional. También se ha demostrado, como los modelos 

ópticos ofrecen un resultado mucho más preciso a cambio de un mayor coste computacional, por 

lo que es clave saber cuándo escoger los modelos ópticos para las simulaciones y cuando un 

modelo empírico es suficiente. Con relación a esto último, para un análisis de un servicio WiFi, 

un análisis empírico es suficiente para conocer una aproximación del alcance de la señal, por lo 

que no será necesario realizar un análisis óptico completo para conocer el alcance de nuestro 

router. 

En el Capítulo 3 también se ha realizado una comparación de diferentes posiciones de los 

router WiFi para evaluar si la colocación actual es óptima o se podría mejorar. Se concluye, que 

pese a la penumbra que deja la columna en la actual ubicación en los dos despachos de enfrente, 

si se hubiera colocado entre ambas columnas, la cobertura final hubiera sido mucho peor, sobre 

todo para el primer despacho. Por lo que se ha podido validar que la actual configuración da un 

mejor servicio que otras. 

Finalmente, en el Capítulo 4, el proyecto se ha centrado en la investigación de dos 

herramientas de análisis de redes WiFi y el funcionamiento de éstas, aplicando el análisis de las 

redes WiFi para realizar la comparación con los modelos de WinProp. Los resultados mostraron 

que ambos programas, NetsPot y WiFi Analyzer, realizan un análisis muy similar, ofreciendo 

unos resultados muy parecidos y con diferencias muy pequeñas, teniendo en cuenta que el entorno 

de trabajo no era el óptimo. Como conclusión de este capítulo, remarcar que, pese a ciertas 

diferencias puntuales, los valores obtenidos por NetSpot se adecuaban bastante a los modelos 

otorgados por WinProp, por lo que podemos concluir finalmente que el programa WinProp, utiliza 

modelos que logran adaptarse bastante bien a los resultados finales. 
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Líneas futuras 

Este proyecto deja abierto una serie de temas para un mayor desarrollo y análisis que no han 

podido ser considerados en este proyecto debido a limitaciones temporales, principalmente, y 

causas de efecto mayor. 

Hemos podido comparar los diferentes métodos con medidas reales obtenidas en la EE. Sin 

embargo, las bases de datos utilizadas en WinProp no incluían los diferentes objetos y obstáculos 

que hay presente por el ala de despachos de la EE. Por lo tanto, a continuación, se exponen ciertos 

trabajos futuros que se podrían realizar para complementar este proyecto. 

 

• En cuanto a la base de datos de WallMan, se podría actualizar teniendo en consideración 

todos los objetos presentes en los diferentes despachos y en el pasillo de la EE. Al haber 

en casi todos los despachos, pizarras y archivadores metálicos, la consideración de los 

efectos de reflexión, dispersión y difracción será mayor por parte de la simulación y, 

probablemente, ProMan se adaptará mejor a los resultados. 

 

• Con relación a la simulación con ProMan, añadir un router que se adapte mejor al presente 

en los pasillos de la EE. El router utilizado en la simulación solo tiene en consideración 

el uso de una señal. Se podría realizar un análisis del router de la EE e importarlo a 

WinProp para que el programa lo considerara en la simulación. También se podrían añadir 

las diferentes señales que el propio router emite, ya que como hemos tratado 

anteriormente un solo router emite la señal de la UAB y la de Eduroam. 

 

• En relación con la campaña de medidas, se podría realizar utilizando nuevas herramientas, 

realizar varias campañas iguales en diferentes momentos e incluso, si cabe la posibilidad, 

desactivar los routers y dispositivos que puedan interferir en la campaña, aunque esto 

último es bastante complicado. 

 

Otro tipo de consideraciones que se podría tener para un futuro proyecto sería comparar las 

medidas obtenidas por el programa y por las campañas de medidas, con los resultados que se 

obtienen de aplicar modelos teóricos de IEEE o de la ITU. 
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https://www.remcom.com/wireless-insite-em-propagation-software
https://altairhyperworks.com/product/FEKO
https://www.netspotapp.com/es/
http://wifianalyzer.mobi/
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ANEXO I: ÍNDICE DE SIMULACIONES 

En este anexo se clasifican los archivos utilizados en las simulaciones del proyecto adjuntas en el 

DVD. 

 

1. Construcción Capítulo 2 WallMan: 

>>Simulaciones_WinProp\Capitulo2\WallMan\rooms_1.idb 

2. Resultados Capítulo 2 ProMan. Modified Free Space Model: 

>>Simulaciones_WinProp\Capitulo2\ProMan\Standard_MFSM_Empirical\Site  1 

Antenna 1 Power.fpp 

3. Resultados Capítulo 2 ProMan. Motley-Keenan Model: 

>>Simulaciones_WinProp\Capitulo_2\ProMan\Standard_MKM_Empirical\Site  1 

Antenna 1 Power.fpp 

4. Resultados Capítulo 2 ProMan. Standard Ray Tracing: 

>>Simulaciones_WinProp\Capitulo_2\ProMan\Standard_SRT_Empirical\Site  1 

Antenna 1 Power.fpp 
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5. Construcción Capítulo 3 WallMan. Escuela de Ingeniería: 

>>Simulaciones_WinProp\Capitulo2\WallMan\ETSE_WM_DB_01.idb 

6. Construcción Capítulo 3 WallMan. Escuela de Ingeniería preprocesada: 

>>Simulaciones_WinProp\Capitulo2\WallMan\ETSE_WM_DB_01.idi 

7. Resultados Capítulo 3 ProMan. ETSE COST-Multi-Wall Model: 

>>Simulaciones_WinProp\Capitulo_3\ProMan\ETSE_MWM_Fresnel\Antena1_QC100

7 Power.fpp 

8. Resultados Capítulo 3 ProMan. ETSE Standard Ray Tracing Model: 

>>Simulaciones_WinProp\Capitulo_3\ProMan\ETSE_SRT_Fresnel\Antena1_QC1007 

Power.fpp 

 

• Modelo router utilizado: router_FF3D.ffe 

>>Simulaciones_WinProp\antenna_router\router_FF3D.ffe 

• Catálogo de materiales utilizado: GlobalMaterialCatalogue.mcb 

>>Simulaciones_WinProp\DEMO\b1_1_WallMan\GlobalMaterialCatalogue.mcb 

• Plano Escuela de Ingeniería: EE_Planta_1.pdf 

>>Simulaciones_WinProp\EE_Planta_1.pdf 
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ANEXO II: WALLMAN 

A. Interfaz de usuario 

 
Anexo Figura I: Interfaz por defecto de WallMan. 

i. Funciones de visualización. 

WallMan nos ofrece vistas en 2D y una vista 3D. Por defecto, cuando creamos una base de 

datos indoor, se nos abren cuatro vistas: XY, XZ, YZ y 3D. 

La vista 3D nos proporciona una visión general de la base de datos en todas sus dimensiones 

y, por lo tanto, ofrece una mejor idea de la estructura que en la vista 2D. Sin embargo, en la vista 

3D no se permite realizar ningún cambio. 

i.a. Navegando en vistas 2D 

Las vistas en 2D de WallMan muestran la base de datos como una sección transversal con 

un cierto plano. Dicho plano se mueve a lo largo del tercer eje y se le llama tercera coordenada. 

En el caso del plano XY, el plano se mueve en la 3ª coordenada Z, mostrando en el plano. En la 

figura I se puede observar un plano semitransparente de color azul, dicho plano es el que realiza 

el corte en la 3ª coordenada. 

 Zoom in, zoom out y zoom window. El zoom window, define el área en que 

será visible la vista. 

 Mouse pan-and-zoom. Al presionar y mantener el botón izquierdo del ratón mientras se 

mueve, se moverá la vista. Presionar el botón derecho amplia la vista. 
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 Zoom selected objects. Centra la vista en los objetos seleccionados. 

 Fit to screen. Centra la vista en el plano completo. 

 3rd Coordinate Settings. Mediante este botón se accede a la ventana de configuración de 

la 3ª coordenada (figura II). Por cada vista existe una 3ª coordenada diferente. La barra de la 

izquierda muestra la posición actual de la 3ª coordenada. En el caso de la figura VIII la posición 

se sitúa en el suelo y su máximo puede ser 4 metros (altura del techo). En el apartado “Marks” 

se pueden añadir marcas de determinadas coordinadas de interés para acceder a ellas más 

rápidamente. 

 
Anexo Figura II: Ventana de configuración de la 3a coordenada en WallMan. 

 

ii. Herramientas de selección 

 Select object. Selecciona la pared u objeto que queramos. Manteniendo Ctrl se pueden 

seleccionar múltiples objetos. 

 Select Multiple Objects. Selecciona los objetos o paredes del área marcada. 

 Select Multiple Objects 3D. Selecciona los objetos o paredes de un área en 3D 

determinada. 

 Select Multiple Objects indide a Polygon. Selecciona paredes u objetos determinados en 

un área poligonal. 

 Select Objects with same Material Properties. Selecciona todos los elementos del plano 

que se compongan del material especificado. 

 Find Object by Number. Selecciona el objeto a través del número de identificación del 

objeto. 

 

iii. Herramientas de construcción. 

 Add Polygonal Objects. Añade objetos o construcciones con cualquier cantidad de 

córneres. Suele ser utilizado para crear el suelo o el techo de la construcción. Cada clic en el ratón 

añade un córner. Para finalizar la construcción, clic derecho. 
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 Add polygonal objects with orthogonal walls and ceiling. Añade una construcción 

siguiendo la herramienta anterior con paredes en los laterales, suelo y techo. 

 Add Rectangular Objects. Crea un plano rectangular en la vista 2D. Se realiza clic en el 

plano para colocar una esquina y de nuevo se realiza otro clic para finalizar la construcción. 

 Add Objects Orthogonal. Crea un plano rectangular que está en ángulo recto con el 

plano de proyección actual. Se aprecia en el plano como una línea. Suele ser utilizado para la 

construcción de paredes en el plano X/Y. 

 Add Pipe Objects. Para crear tuberías cilíndricas. Al realizar clic sobre el plano, se abre 

una vista para configurar las especificaciones. 

 Combine Objects. Combina dos objetos para que sean uno. 

 Connect two walls. Conecta dos muros ya existentes con un tercer muro seleccionando 

las esquinas de éstos. 

 

B. Importación de archivos GIS o CAD 

Para poder importar un archivo GIS en WallMan, crearemos un nuevo proyecto y 

seleccionaremos la opción Convert File en la ventana de la figura III. Si queremos utilizar un 

catálogo de materiales deberemos introducirlo en el apartado de Material Catalogue. 

 

Anexo Figura III: Tipo de database en WallMan, seleccionando la importación de archivos. 

De la misma manera que en cualquier otra Database, deberemos introducir los valores por 

defecto de los nuevos objetos que vayamos a crear. 

Una vez introducidos dichos valores se nos abrirá una ventana como la de la figura IV dónde 

deberemos especificar el tipo de archivo GIS o CAD que queremos importar para la creación de 

nuestra database. Los archivos compatibles son los de siguiente formato: ida, dwg, dxf, fac, stl, 

nas y obj. Si se desea se puede realizar una simplificación del procesado, pero no entraremos en 

detalle en dicho proyecto. 
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Para la realización de dicho ejemplo se ha utilizado un modelo gratuito en formato obj. Una 

vez seleccionado el archivo, se nos abrirá una ventana como la figura V. Dicha ventana nos 

permite realizar rotaciones en el plano importado, traslaciones por los ejes X, Y o Z y escalado 

del plano para reducir su tamaño. 

 

Anexo Figura IV: Especificación del tipo de archivo a importar. 

 

Anexo Figura V: Ventana de transformación de la database importada. 

Pulsamos en OK y dejamos que WallMan realice el procesado de la base recién importada. 

Una vez finalizada la importación podremos trabajar en ella. 
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ANEXO III: PROMAN 

A. Interfaz de usuario 

 
Anexo Figura VI: Interfaz por defecto de ProMan 

1. Herramientas básicas    4. Herramientas de utilidad 

2. Herramientas de proyecto    5. Herramientas de edición 

3. Herramientas de componente 

 

1. Herramientas básicas 

 New Project. Abre un nuevo proyecto. 

 Open Project. Abre un Proyecto existente. 

 Open Result. Abre un archivo ProMan con los resultados de una simulación. 

 Open recent file. Abre un archivo reciente. 

 Save. Guarda el proyecto. 

 Export bitmap. Exporta un archivo BMP con la imagen de lo visible en la ventana 2D. 

Te permite añadir de manera opcional la leyenda. 

 Version. Muestra información de la versión de ProMan. 

 

2. Herramientas de proyecto 
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 Edit project parameters. Abre la ventana de configuración de parámetros. 

 Set site. Escoge la ubicación para colocar la estación base o punto de acceso. 

 Erase site. Borra la estación base seleccionada. 

 Edit site. Abre la ventana de configuración de la estación base. 

 Move site. Permite mover una estación base de lugar. 

 Set transmitter. Coloca una antena transmisora en una estación base. 

 Enable/disable transmitter. Activa o desactiva una antena transmisora. 

 Erase transmitter. Borra una antena transmisora de una estación base. 

 Edit transmitter. Abre la ventana de configuración de la antena transmisora. 

 Se utiliza para cambiar la orientación de la antena. Horizontal o vertical. 

 Prediction Rectangle. Establece el área de predicción que realizará ProMan. Por defecto 

realiza un análisis en el área del plano importado desde WallMan. 

 Run Project. Realiza la simulación para todas las antenas. 

 

3. Herramientas de utilidad 

Dependiendo de los parámetros escogidos para la simulación, algunas de las siguientes 

herramientas no estarán disponibles. 

 Display of ray paths. Muestra en la vista 2D la ruta del rayo con mayor intensidad. 

Dependiendo de la configuración, muestra más de una ruta. 

 Single display of rays. Al seleccionar un punto en el plano, se abre una ventana dónde 

se puede seleccionar manualmente las rutas a mostrar. 

 Delete all rays. Borra cualquier ruta de la vista 2D. 

 Impulse response. Muestra una gráfica temporal con la respuesta impulsional en el punto 

seleccionado en el plano. 

 Line plot. Muestra una gráfica de potencia respecto una línea marcada. Más detalles a 

continuación. 

 Line plot (from transmitter). Muestra una gráfica de potencia respecto a una línea 

marcada con origen en el transmisor. Más detalles a continuación. 

 Ballon tip. Muestra el valor de la potencia en un punto determinado del plano 2D. El 

equivalente de antena utilizada es una isotrópica de 0dB de directividad. 

 Distance. Herramienta de medida de distancia en el plano 2D. 
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B. Herramienta Line Plot 

 Line Plot 

 Line Plot (from transmitter) 

A través de dibujar una línea, el programa calcula los niveles de potencia en la línea 

marcada y genera el gráfico con los valores de potencia (figura VII y figura VIII). 

La herramienta Line Plot (from transmitter) realiza la misma función, pero con el punto de 

inicio fijado en el transmisor. 

 
Anexo Figura VII: Creación de la línea para dibujar la gráfica de la siguiente figura. 

 
Anexo Figura VIII: Gráfica generada con la herramienta Line Plot siguiendo la línea marcada en la figura anterior. 

En el gráfico resultante, haciendo clic derecho en éste, podemos escoger en la opción Settings, 

diferentes modos de visualización y la escala de éste. En la pestaña Layout (figura IX) se puede 

configurar la leyenda y habilitar el grid del gráfico. En la pestaña Data (figura X) podemos 

escoger el modo de visualizar los datos y en el apartado Scaling (figura XI) la escala del gráfico, 

tanto para el eje X como el Y. 
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Anexo Figura IX: Configuración de la vista del gráfico. Pestaña Layout. 

 
Anexo Figura X: Configuración de la vista del gráfico. Pestaña Data. 

 
Anexo Figura XI: Configuración de la vista del gráfico. Pestaña Scaling. 
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ANEXO IV: CONFIGURACIONES 

A. Medidas de muros y paredes 

A continuación, se muestra una tabla con los materiales que se han utilizado para la 

construcción del edificio de Ingeniería y sus características. 

Aplicación Material Tamaño 

Muros exteriores Brick (ladrillo) 30 cm (medido) 

Paredes interiores pasillo Brick (ladrillo) 20 cm (medido) 

Paredes interiores despachos Plaster (pladur) 10 cm (aproximado) 

Ventanas Glass (vidrio) 5 mm 

Puertas despachos Wood (madera) 5 cm (medido) 

Suelo Concrete (Hormigón) 30 cm 

Tejado Concrete (Hormigón) 30 cm 

Paredes interiores escalera Concrete (Hormigón) 20 cm (medido) 

Ancho del pasillo -- 2.10 metros (medido) 

 

B. Tiempo de procesado 

A continuación, se adjunta una tabla recopilatoria del tiempo computacional de todas las 

simulaciones realizadas mediante ProMan y WallMan 

Nombre archivo de simulación Tiempo procesado 

Capítulo 2 (>>Simulaciones_WinProp\Capitulo2\ProMan\...) 

Full_IRT_Empirical 2 min 

Full_IRT_Fresnel 2 min 

Full_MWM_Empirical < 1 min 

Full_MWM_Fresnel < 1 min 

Full_SRT_Empirical 3 min 

Full_SRT_Fresnel 3 min 

Standard_DPM_Empirical < 1 min 

Standard_DPM_Fresnel < 1 min 

Standard_MFSM_Empirical < 1 min 

Standard_MFSM_Fresnel < 1 min 

Standard_MKM_Empirical < 1 min 

Standard_MKM_Fresnel < 1 min 

Standard_MWM_Empirical < 1 min 

Standard_MWM_Fresnel < 1 min 

Standard_SRT_Empirical 2 min 

Standard_SRT_Fresnel 2 min 

Capítulo 3 (>>Simulaciones_WinProp\Capitulo3\WallMan\...) 

Preprocessing_WM_ETSE_001.pin 15 min 
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Capítulo 3 (>>Simulaciones_WinProp\Capitulo3\ProMan\...) 

ETSE_IRT_Empirical 2 h 30 min 

ETSE_MWM_Empirical < 1 min 

ETSE_MWM_Fresnel < 1 min 

ETSE_SRT_Empirical 1 h 31 min 

ETSE_SRT_Fresnel 1h 35 min 

 

 

 

C. Características computacionales 

Sistema Operativo: Windows 10 Home 

Procesador: AMD A6-9220 RADEON R4, Cores 2C+3G   2.50 GHz 

Memoria (RAM): 8,00 GB (7,47 GB utilizable) 

Tipo de sistema: 64 bits, procesador x64 

GPU: AMD Radeon™ R4 Graphics 4,2 GB 

 

 

D. Medidas experimentales 

Las medidas experimentales se han realizado a través del promedio de varias iteraciones que el 

programa ofrece. Aquí se recogen todas las iteraciones y su valor promedio. Referencia: Figura 

70: Esquema de planificación de las medidas realizadas. Página 64. 

 

Ubicación (ref. ProMan) Iteraciones (dBm) Promedio 

1. x = 105.35, y = 46.03 -53, -54, -52, -58, -57, -54, -54, -56, -53, -54 -54.5 dBm 

2. x = 105.35, y = 42.95 -50, -52, -52, -53, -53, -53, -52, -52, -54, -56 -47.4 dBm 

3. x = 105.35, y = 41.01 -41, -40, -40, -40, -40, -38, -37, -37, -39, -40 -39.2 dBm 

4. x = 106.89, y = 41.88 -47, -45, -43, -38, -37, -39, -38, -39, -38, -39 -40.3 dBm 

5. x = 108.55, y = 46.03 -46, -47, -48, -48, -48, -48, -47, -48, -47, -47 -47.4 dBm 

6. x = 110.39, y = 41.88 -50, -44, -40, -43, -44, -46, -44, -46, -45, -46 -44.8 dBm 

7. x = 113.38, y = 41.88 -37, -36, -35, -36, -40, -40, -41, -40, -41 -38.7 dBm 

8. x = 117.38, y = 41.88 -46, -42, -39, -42, -41, -40, -40, -40, -39 -41.0 dBm 

9. x = 120.89, y = 42.95 -60, -62, -63, -64, -64, -66, -66, -66, -64, -61 -63.6 dBm 

10. x = 120.89, y = 41.88 -53, -51, -52, -51, -56, -51, -51, -49, -50, -50 -51.4 dBm 

11. x = 120.89, y = 41.01 -61, -61, -61, -61, -59, -62, -62, -58, -59 -60.4 dBm 

12. x = 124.33, y = 41.88 -54, -55, -53, -54, -57, -56, -57, -57, -54, -60 -55.7 dBm 

13. x = 112.37, y = 39.7 -47, -49, -47, -49, -53, -49, -47, -49, -48 -48.5 dBm 

14. x = 110.51, y = 39.7 -54, -52, -51, -50, -51, -50, -50, -50, -50, -50 -50.8 dBm 
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15. x = 110.51, y = 36.1 -50, -51, -48, -51, -51, -50, -52, -49, -50, -51 -50.3 dBm 

16. x = 112.37, y = 36.1 -49, -50, -53, -51, -48, -54, -52, -51, -50, -50, -51 -50.5 dBm 

17. x = 110.51, y = 34.1 -51, -51, -51, -53, -53, -53, -50, -49, -51, -50, -47 -50.8 dBm 

18. x = 112.37, y = 34.1 -56, -54, -52, -53, -55, -54, -53, -52, -52, -52, -52 -53.2 dBm 

 


